
     MegaWord does it again! 
Introducing the world’s #1 productivity package for WinWord 95.

Let there be no misunderstanding. The real trendsetter in professional add-ins for Microsoft Word for Windows is 
MegaWord. 

MegaWord was the world’s first add-in for WinWord 6.0. 
MegaWord was the world’s first add-in for Word 6.0 for Windows NT 
MegaWord was the first truly international WinWord add-in, available in English, German, French and Dutch.
And now there’s MegaWord 95, the world’s first productivity package for Word for Windows 95.

MegaWord has always been the frontrunner introducing new features to Word that have later been copied by 
competitors, or implemented by Microsoft itself. Previous versions of MegaWord came with innovative features such 
as Character Styles, Fast Format, Switchable Toolbars, Proportional Super- and Subscripts, Table 3D-effects and 
instant Spell Checking long before Microsoft implemented them. 
MegaWord also pioneered the use of the SHIFT and CTRL key to run more than one command from the same menu 
or toolbar button, a feature that is now also becoming commonplace in Word. 
And MegaWord’s original applications for File, Project and View Management have been widely copied (but never 
surpassed) by other developers of add-ins.

Seamless integration. Finally, MegaWord has always been an exemplary well-behaved add-in. It’s the only package
that manages to customize WinWord to its outer limits, and still never disables existing Word functions. Every original
Word command that’s enhanced by MegaWord can still be run if you simply hold down the SHIFT key when you run 
the MegaWord replacement. No other add-in offers such seamless integration.



  The critic's choice
Here’s what others said about the previous version of MegaWord

MegaWord... "offers the richest set of unique functions available in any add-in for Word" - Edward 
Mendelson, PC Magazine, June 14, 1994 (Reviewing MegaWord, WOPR and Alki Masterword)

"Romke Soldaat, virtuoso WordBasic expert, has assembled a nonpareil collection of ultra-cool stuff you 
should see. Everything from novice user assists to fancy, fancy macros" - Woody Leonhard in the "Underground 
Guide to Word for Windows", Addison-Wesley, 1994

"MegaWord has a wealth of features for both the casual and serious user of Word for Windows, and I'll bet 
you'll see some of these features from Microsoft when they next redo the word processor" - Ed Hoffman, Computer 
Press Association Network News, 1994

"This is a well thought out add-in to the most popular Windows word processor available. Even if you only 
use a quarter of the extras on offer, it's worth the asking price." - Simon Williams, PC Plus (UK), December 1994



    What’s new in MegaWord 95?
In this newest incarnation of MegaWord we’ve dramatically enhanced the highlights of the previous version, made 
them faster and gave them a pretty Windows 95 look (including those hot tabbed dialog boxes). 

Check out the new versions of Project Manager, MultiPrint, Document Recall, FastProof and View Manager. 
We’ve also integrated many old MegaWord features into brand new single applications, making them easier to 
access. 

But most importantly, we’ve added a host of new trendsetting features, such as Explorer, HotPad, Repeat Format, 
Format Cycler, Style Hopper, Word Optimizer, Table AutoFill, Virus Alert and Font Manager. Tools that are truly 
innovative and add real productivity to your daily word-processing activities. 

Look out for more Mega news!
Many users asked us “why isn’t there a MegaExcel or MegaAccess?” Here’s the good news: we have started the 
development of additional “Mega” tools for the Microsoft Office suite. The first product in this range will be 
MegaOffice™, a package that makes many MegaWord features available in all Office applications. The release of 
MegaOffice is scheduled for the first quarter of 1996. As far as MegaExcel, MegaAccess (and possibly 
MegaPowerpoint) are concerned, we’re open to suggestions!

Attention Excel and Access developers!
Would you like to contribute to MegaExcel and MegaAccess? We’re looking for developers who can write 
applications that are just as powerful as the ones in MegaWord. We’re interested in true innovations, and user-
friendly tools that unleash and increase the power of all Office applications. We offer either a one-off fee, or 
remuneration on a royalty basis.



    MegaWord 95 Overview
The following list gives you an alphabetical bird’s eye view of the MegaWord 95 package. 

Click on any icon to display the associated Help page.

            Button Picker.   Gives you the easiest and fastest way to modify or add new buttons to your toolbars
            Date Manager.   Lets you insert Dates and Calendars, and is a powerful Date Calculator at the same time
            DocBrowser.   Lets you interactively jump through long documents and gives statistical information while you

browse
            Doc Hopper.   Instantly creates a text index based on a selected style, and lets you jump to any document 

location in a split second.
            Document Recall.   Keeps a database of all the documents, templates and folders you’ve worked with, and 

lets you reuse anyone of them without having to find them.
            Explorer.   The File Manager with a difference: it lets you do 1001 things with the document you’re currently 

working on: copy, move, rename, delete, create a shortcut, place it on the desktop, add inside information, etc.
            FastProof.   Checks the spelling of any word under the cursor, and gives you synonyms at the same time. 

More options than Word's new spelling popup menu!
            FastSort.   Makes sorting paragraphs and tables a snap
            FastSwitch.   Makes working in Full Screen mode a lot easier
            Font Manager.   Brings order in your font jungle. Apply fonts from user defined font groups rather than from a 

never ending list
            Format Cycler.   Adds one of Lotus WordPro’s hot new features to Word for Windows: cycling through preset 

formats with your mouse.
            HotPad.   Gives you finally a way to make your numeric keypad productive!
            MultiPrint.   More printing features than you could ever imagine, including AutoFax, PrintStats and Mail 

integration. 
            Number Manager.   Lets you insert any number, in any format, in any language
            Project Manager.   Lets you manage groups of related files as a Project, and automatically recreates your 

last Word session.
            Repeat Format.   Lets you repeat and copy any format, not just the Font and Paragraph format
            ShutDown.   Closes Word, and optionally shuts down Windows in three different ways.
            SmartSplit.   Lets you split document windows in more ways than Word wants you to
            Special Characters.   Gives you the intelligent tool to insert symbols and special characters in your 

document
            Surround Selection.   Forget complex key codes for placing text between quotes, brackets and dashes. 

Surround Selection does it in a single button click.
            Table 3D Effects.   Takes your tables to a new dimension: the third!
            Table Toolbar.      The toolbar Microsoft forgot
            Table AutoFill.   Brings Excel's AutoFill feature to Word - and more!
            Task Switcher.      Activates any currently running application, optionally placing it on top of other windows, or

side by side with Word.
            View Manager.   Lets you name and recreate any View, and lets you decide how Word displays your 

document
            Virus Altert.   Keeps harmful document viruses out of your system.
            Window Manager.   Lets you manipulate document windows in more ways than you could imagine
            Word Count.   Counts words (and more!) and gives readability statistics    for any part of your document
            Word Lock.   Instantly hides Word behind a full-screen password dialog box. And only you can unlock it!
            Word Optimizer.   Lets you tweak Word for optimum performance, and personalize Word's standard settings
            Zoom Manager.   Gives you ultimate control over Word’s zoom features, plus two hotkeys for instant zooming

in and out.



    Credits & Legalities
Every part of the MegaWord software and documentation is © 1993-95 Merlot International / Romke Soldaat. All 
Rights Reseved.

MegaWord™, MegaExcel™, MegaAccess™, MegaPowerpoint™ and MegaOffice™ are trademarks of Merlot 
International / Romke Soldaat. 

All other trademarks mentioned in the MegaWord documentation and software are the properties of their respective 
owners.

Users of MegaWord must accept this disclaimer of warranty:

 "MEGAWORD IS SUPPLIED AS IS. THE AUTHOR DISCLAIMS ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, 
WITHOUT LIMITATION, THE WARRANTIES OF MERCHANTABILITY AND OF FITNESS FOR ANY PURPOSE. THE AUTHOR 
ASSUMES NO LIABILITY FOR DAMAGES, DIRECT OR CONSEQUENTIAL, WHICH MAY RESULT FROM THE USE OF 
MEGAWORD."

The MEGALIB.DLL function library was written by David Lowndes. He is the author of many other cool Windows 95 
utilities. His CompuServe email address is 100524,3072.

Parts of some macros are based on, or inspired by, code published in the Hacker’s Guide to Word for Windows, 
Second Edition, written by Woody Leonhard, Vince Chen and Scott Krueger, published by Addison Wesley, 1994.

Many thanks to Vince Chen for providing the hack to retrieve a printer list from the Windows registry, used in 
MegaWord MultiPrint!



    Installing MegaWord 95
System Requirements

You can only use MegaWord 95 with the Microsoft Office for Windows 95 Preview or final release, or with 
the standalone version of Word for Windows 95, version 7.

Your operating system must be Windows 95, or Windows NT version 3.51. 
To install all MegaWord 95 components, you need 1.5MB available disk space.

File locations
Since all MegaWord features (macros, toolbars, menu and keyboard assignments, and AutoText entries) are 
presented in the form of a single add-in template, installation is very easy. If the Setup program didn’t do the 
installation for you, or if the automatic installation made a mistake, you should copy the !MEGA_95.DOT file to the 
following subdirectory of your WINWORD folder (for other language versions, please refer to your Word User’s Guide):

Language Version Subdirectory
English STARTUP
German AUTOSTRT
French DEMARRE
Dutch WRDSTART

Don’t modify the Template!
It is NOT recommended to copy parts of the MegaWord template to NORMAL.DOT or another template. Many 
macros in this template rely on each other, and cannot be separated from the original template. For the same reason 
you should not delete or rename macros in this template, nor rename !MEGA_95.DOT. Technical support is only 
available if the original template is intact! 

It is a common misunderstanding that deleting macros from an add-in template saves memory. This is definitely not 
true. Word will only use additional memory when you actually start using add-in macros. If there are some MegaWord
applications that you don’t want to use, the best way to disable them is by removing the associated button from the 
MegaWord toolbar.

Running MegaWord 95 on non-English versions of WinWord
MegaWord 95 is designed and optimized to run with English, French, German and Dutch versions of Word 7.0 for 
Windows 95. Some macros may not run properly with other language versions of Word. 



    Disabling and Uninstalling
MegaWord 95

You can at any time disable MegaWord 95. The steps:
1 Choose File/Templates
2 Remove the checkmark in front of the !MEGA_95.DOT template. 

To remove MegaWord 95 from your system, do the following:
1 Open the Control Panel
2 Choose "Add/remove Programs"
3 Select "MegaWord 95"
4 Click Add/Remove.



    Help and Tips
To display this Help file, choose Help in the Mega menu.

Most MegaWord 95 dialog boxes have a Help button which gives direct access to the associated Help page. To 
facilitate reading the Help page, the dialog box from where you request help is automatically moved to the left edge of
your screen. 

In addition, many dialog boxes have a Tip button, which gives you information about specific start options for that 
MegaWord application.

Choose “About MegaWord” from the Mega menu and select the Help tab to get instant online Help about any 
MegaWord tool.



 Tip of the Day
Each time you start Word, a “Tip of the Day” is displayed in the upper left corner of your screen. Each tip tells you 
how to get the most out of MegaWord. If you don’t want to see these tips, you can disable this feature from the 
MegaWord About box (Mega menu).

 Show first Tip of the Day



 Using MegaWord in protected documents, binders and 
email messages
Using MegaWord in protected documents
Word documents can be protected in a number of ways. Some forms of protection make it impossible to edit the 
document, or to run certain commands. In those situations, some MegaWord tools will not run, even if you click the 
associated toolbar button.

Using MegaWord in binders and email messages
Starting with version 7.0, Word can also be used as an object in an Office Binder or as your email editor. When a 
document is used in these environments, many commands are not available, or only available to a limited extent. 
MegaWord tries to determine whether you’re working inside a binder or email object, and disables macros that are 
not relevant or that can’t run for technical reasons. Most tools that manipulate files and windows are disabled inside a
binder or email object.



 MegaWord 95 Toolbars
Nearly every MegaWord tool can be accessed directly from the two MegaWord toolbars, named Mega 1 and Mega 2.
Most icons on the toolbar are self-explanatory. Placing the cursor on top of an icon for a second will give you a textual
hint of its meaning. (If you don’t see these tool tips, check the “Show Tooltips” box in the View Toolbars dialog box.) 
For additional information, look at the statusbar. In this help file we use the toolbar icons as a visual reference in the 
heading of each application description. 

Moving/removing Toolbar Buttons
If you like, you can move one or more buttons from the MegaWord toolbars to another toolbar.

To move a button from one toolbar to another, hold down the ALT key and drag the button from the original 
toolbar to the new toolbar.

To delete a button from a toolbar, hold down the ALT key and drag the button into the workspace.

Permanently hiding the MegaWord Toolbars
If you have copied or moved buttons from the Mega toolbars to other toolbars, you can tell MegaWord not to display 
the Mega toolbars anymore at startup. Choose “About MegaWord” from the Mega menu, select the Startup tab and 
uncheck the "How Mega toolbars" box.



 Technical support
The easiest and quickest way to get technical support is by contacting us via email:

CompuServe: 100273,32
Internet: 100273.32@compuserve.com

You can also contact us at the following address:

Merlot International
Romke Soldaat
1, chemin des Moulines
34230 St. Bauzille de la Sylve
FRANCE

Tel:(+33) 67.57.55.88
Fax: (+33) 67.57.20.87

We are committed to supplying instant feedback on your request, but please keep in mind that we’re a small 
company, and we do take holidays once in a while!



    MegaWord Explorer

    Options...

MegaWord Explorer is the unique File Manager that works with only one file: the document you’re working on.

Running Explorer 
To display the Explorer dialog box, click 

.

In addition, you can hold down the SHIFT and/or CTRL key while you click  to display miscellaneous information on 
the titlebar. When the Explorer dialog box is displayed, four tabs offer you many options to manipulate the current 
document.

{button ,KL(`Explorer')} How do I work with the MegaWord Explorer?



    Renaming the current document

 Start of    topic      
 More options...

1 Click .
2 Display the File Action tab.
3 In the Filename box, type a new name.
4 Click Rename.

If a file with the new name already exists in the same folder, you will get the option to overwrite the old file, or to 
specify a different name.

Tip    Use Explorer to give descriptive filenames of up to 255 characters to documents created in previous versions of 
Word.



    Deleting the current document

 Start of    topic      
 More options...

1 Click .
2 Display the File Action tab.
3 Click Delete.

You will be prompted to confirm the deletion.

Note    In some cases you may notice that the file can’t be deleted; this specifically occurs if you have pasted 
information from the document to the Clipboard. If that happens, open a different document, copy some text to the 
Clipboard, return to the original document and try to delete it again.



    Copying or moving the current document

 Start of    topic      
 More options...

1 Click .
2 Display the File Action tab.
3 In the Filename box, type a new name if required.
4 Select the target folder for the document.

{button ,JI(`>BackInfo',`IDH_HOWTO_FINDFOLDER')}  How?
5 To make a copy of the document in the destination folder, click Copy. 
To move the document to the destination folder, click Move.

If a file with the same name already exists in the destination folder, you will get the option to overwrite the old file, or 
to specify a different name.



    Creating a shortcut to the current document

 Start of    topic      
 More options...

1 Click .
2 Display the Shortcut tab.
3 In the Shortcut Name box, type a different name if required (the default is the current filename).
4 Select the target folder for the shortcut. 

{button ,JI(`>BackInfo',`IDH_HOWTO_FINDFOLDER')}  How? (See also the Note below)
5 Click Create.

Note    To quickly create a shortcut to the current document in any of the special Windows or Word folders, make your
selection from the “Quick-select Folder” list.

{button ,JI(`>BackInfo',`IDH_HOWTO_SHORTCUTWHAT')}    What exactly is a shortcut?
{button ,JI(`>BackInfo',`IDH_HOWTO_SHORTCUTFOLDERS')}    What are these "special folders"?



    Selecting a destination folder in the Explorer dialog box

 Start of    topic      
 More options...

Use the two lists to select the destination folder. 
The first list holds all available drives on your system and any folders located "higher" than the folder of 

which the name is displayed. Select any target from this list, or click 
 to move up one level. Click 
 to select the “Favorites” folder. 

The bottom list holds all folders located “lower” than the folder of which the name is selected. Double-click a 
subfolder to make it the active folder.

To copy or move the document to a folder that does not exist yet, click New Folder to create a new target 
destination under the selected folder. After you have specified a valid name for the new folder, it immediately 
becomes the active folder.

To copy or move the document to a folder on a network drive that has not been activated yet, click Network 
to make the required connection.



    Special destinations for shortcuts

 Start of    topic      
 More options...

You can place a shortcut in any folder on your system or on the network. Some folders on your system have a special
meaning. 

A shortcut in the Desktop folder, places your document on your computer’s desktop. This gives you by far 
the quickest access. This method is recommended if you often work on the same file, or if you expect to need that file
for an extended period of time. 

A shortcut in the Programs folder puts your shortcut in the “Programs”    section of the Start menu. The 
“Programs” folder usually holds a number of subfolders which appear as right-pointing triangles on the Start menu. 
You can place your shortcut in any of these folders.

A shortcut in the Start Menu folder puts your shortcut on the Start menu, which makes it immediately 
available when the Start menu becomes visible.    

A shortcut in the Startup folder has the effect that the associated document is immediately loaded when you
start Windows. If the document has the .DOC extension, Word is started, with the document active. 

The Favorites folder is designed to store shortcuts to files of interest, including those in network locations. 
To open a favorite file click    
 in the File/Open dialog box, and then double-click the shortcut. 

The My Documents folder is Word’s default folder, and is a good place to store shortcuts to documents 
you're currently working on. To open a document from this folder, double-click the shortcut. 



What is a shortcut?

A shortcut is a sophisticated method to reference a file, and place that reference in a different location than the file 
itself. You can create shortcuts to applications, folders or documents, and activate these by double-clicking their icon. 
Windows knows the original location of the referenced file, and will run the application, activate the folder, or open the
document for you.

MegaWord Explorer and Document Recall use this technique to create shortcuts to documents, templates and 
folders, allowing you to reuse them in the future without having to remember where the original document is located.

Shortcuts appear in Windows dialog boxes as regular files. If you have set up Windows to show large file icons, a 
little  symbol in the lower left corner of the icon identifies a shortcut.



    Storing "Inside Info" in the current document

 Start of    topic      
 More options...

{button ,JI(`>BackInfo',`IDH_HOWTO_INSIDEINFOWHAT')}    What exactly is Inside Information?

1 Click .
2 Display the Inside Info tab.
3 Click New Info
4 In the Inside Information Identifier box, type a unique identifier (or "nickname")
5 In the Associated Text box, type the information you want to store. (See also the Note below)
6 Click Add.

Note    To add the currently selected document text as Inside Info, type ^s in the Associated Text box. This will store 
up to 10,000 characters of the unformatted selected text as Inside Info.

Modifying Inside Info
1 In the Inside Information Identifier box, select the identifier
2a To replace the current Inside Info, right-click in the Associated Text box to select the current contents. Press the 

DELETE key to clear the box, then type your new Inside Info
To add text to the Inside Info that is already there, move the cursor to the end of the current Inside Info, and type 
the additional text. 

3 Click Add.

Deleting Inside Info
1 In the Inside Information Identifier box, select the identifier
2 Click Delete.

Inserting Inside Info in the Document
1 In the Inside Information Identifier box, select the identifier
2 Click Insert.

Reading and modifying Document Properties
Click Properties to display the properties for the current document. When the Properties dialog is displayed, you can 
change any document properties and confirm the changes by clicking OK. 



    What is Inside Information?

 Start of    topic      
 More options...

Word lets you add information to your document which is not visible when the document is open, and cannot be 
accessed from the Properties dialog box. This allows you to save hidden version information with the document, or 
text that you want to keep separate from the actual document contents. Adding, reading or deleting this “Inside 
Information” is one of the options of the Explorer dialog box.

Inside Info basics
Working with Inside Info is much like working with AutoText. Each piece of Inside Info is stored under a name that 
uniquely identifies the stored text. For example, you can store the text “Hello world” under the identifier “Greetings”, 
just as you can do with AutoText entries. Each bit of Inside info can in theory have a length of up to 65,280 
characters. For practical reasons, Explorer limits Inside Info to text of up to 10,000 characters.

Displaying and Reading Inside Info
When you activate the Explorer “Inside Info” tab, you see two lists. The “Inside Information Identifiers” list holds all 
identifiers (“nicknames”) that represent Inside Info stored in the document. The “Associated Text” box shows a 
preview of up to the first 255 characters of the associated Inside Info. If the Inside Information is longer than 255 
characters, you’ll see the string "[more...]" at the end of the Inside Info. If you want to read the entire Inside 
Information, click Show Full Info to display a message box that displays the full stored text.



    Displaying information on the titlebar

 Start of    topic      
 More options...

After you have set up the titlebar choices as described below, you can display the selected type of information on the 
titlebar as follows:
1 Hold down the SHIFT and/or CTRL key
2 Click .

Setting up titlebar choices
1 Click .
2 Display the Titlebar tab.
3 In each list, select the type of information you want to associate with the SHIFT and/or CTRL key. See 
Titlebar Options below.
4 To see the effect of each choice, click Demo
5 Specify the number of seconds after which you want to restore the original titlebar. (See also the Note 
below)
6 Click Confirm.

Titlebar Options
Full Pathname. Displays the full pathname and the extension of the document.
Document Title. Displays the filename and the Title (as specified in the Properties dialog box)
Statistics. Displays the filename, word counts and the filesize.
Create, Save and Print Date. Displays the filename and the dates/times the document was created, last 

saved and last printed.
Current Date and Time. Displays the filename and the current date and time.

Note    Word doesn’t let you change the titlebar permanently. As soon as you save a document or activate another 
document, the original titlebar is restored. Within these limits you can restore the titlebar after a set number of 
seconds, as specified in the "Restore Titlebar after" box. Specify zero to leave the modified titlebar active as long as 
possible.



    What do you want to know?

How to:
{button ,JI(`>HowTo',`IDH_HOWTO_RENAME_CURDOC')} Rename the current document 
{button ,JI(`>HowTo',`IDH_HOWTO_DELETE_CURDOC')} Delete the current document
{button ,JI(`>HowTo',`IDH_HOWTO_COPYMOVE_CURDOC')} Copy/move the current document



    Project Manager

    Options...

MegaWord Project Manager brings the concept of Document Projects to WinWord. If you often work on a number of 
related documents (book chapters, mail merge documents, forms, macros, etc.) at the same time, you can now open 
them with a single command. A project can consist of any number of documents, scattered over any number of 
folders or network paths. 

Project Manager can also quickly save your current Word session as a project, and restart your next session with the 
same documents. There’s even an option to save and restore Word sessions automatically. 

Running Project Manager
To open the Project Manager dialog box, click 

, or choose Project from the File menu. 

{button ,KL(`Project Manager')} How do I work with Project Manager?

Upgrade Info    If you already created projects with the Project Manager of MegaWord 6, they are 
automatically converted to the new format the first time you run Project Manager.



    Creating a project

 Start of    topic      
 More options...

1 Click .
2 Display the New Project tab. The list on the left shows all currently open documents, the list on the right will 
hold the documents you want to include in the project.
3 Double-click a document name to move it from one list to the other. To move all documents, hold down 
SHIFT and double-lick any file in the list.
4 When you have shortlisted the project documents, type a valid project name in the Assign Documents to 
Project box
5 Click Save Project.

{button ,JI(`>BackInfo',`IDH_HOWTO_PROJECTNAME')}    What is a valid project name?



    Opening or printing a project 

 Start of    topic      
 More options...

To open all documents and/or macros included in a previously created project, do one of the following:

Method 1
1 Click .
2 Display the Projects tab
3 In the Current Projects list, select the project you want to open
4 Click Open Project

Method 2
1 Hold down the CTRL key and click . This displays the Open dialog box with all project files.
2 Double-click the project filename to open all files in that project

Method 3
In the Explorer (Windows 95) or File Manager (Windows NT), double-click a file with the .pro extension. If 

Word isn’t running, it will automatically be started for you.

To open more than one project, check "Open Multiple Project or Files".
To open project documents and immediately activate the selection where the last edit was made, check 

"Highlight Last Edit when opening Documents".

Printing a Project 
1 Click .
2 Display the Projects tab
3 In the Current Projects list, select the project you want to print
4 Click Print Project



    Opening or printing a single project document

 Start of    topic      
 More options...

1 Click .
2 Display the Projects tab
3 In the Current Projects list, select the project that holds the document you want to open or print
4 In the Files in Project list, select the document you want to open or print
5 Click Open File or Print File

To open a project document and immediately activate the selection where the last edit was made, check 
"Highlight Last Edit when opening Documents".



    Renaming or deleting a project

 Start of    topic      
 More options...

To change the name of an existing project, do one of the following:

Method 1
1 Click .
2 Display the Projects tab
3 In the Current Projects list, select the project you want to rename
4 Click Rename Project
5 Specify a new valid name 
6 Click OK

Method 2
Select a file with the .pro extension in Word’s File Open dialog box, or in the Explorer (Windows 95) or File 

Manager (Windows 95) and rename the file. Make sure to specify a valid name.

{button ,JI(`>BackInfo',`IDH_HOWTO_PROJECTNAME')}    What is a valid project name?

To delete a project, do one of the following:

Method 1
1 Click .
2 Display the Projects tab
3 In the Current Projects list, select the project that you want to delete
4 Click Delete Project. You will be prompted to confirm before a project is removed. To bypass the prompt and 
remove a project without confirmation, hold down the SHIFT key while you click Delete Project.

Method 2
Select the project file in Word’s File Open dialog box, or in the Explorer (Windows 95) or File Manager 

(Windows 95) and delete the file. 

Note    Deleting a project will not delete the files that are included in the project; only the associated .pro file will be 
deleted from the Projects folder. 



    Adding the current document to a project

 Start of    topic      
 More options...

1 Click .
2 Display the Projects tab
3 In the Current Projects list, select the project to which you want to add the current document.
4 Click Add Current Doc



    Modifying a project

 Start of    topic      
 More options...

To delete a file from an existing project, do the following:

1 Click .
2 Display the Projects tab
3 In the Current Projects list, select the project that holds the document you want to remove
4 In the Files in Project list, select the document you want to remove
5 Click Remove File

To replace the contents of an existing project, or add one or more open documents to an existing project, do the 
following:

1 Click .
2 Display the New Project tab. 
3 In the Assign Documents to Project box, select the name of the project you want to modify.
4 In the list of the left, double-click the document you want to add. To add all documents, hold down SHIFT and
double-lick any file in the list.
4 In the What if selected Project already exists group, select the appropriate option. (See Options below)
5 Click Save Project.

Options Before you click Save Project, select the appropriate option: 
Add Documents to existing Project means that the selected documents will be added to the files that are 

already in the project.
Overwrite existing Project means that the existing project will be deleted and replaced with a new project of 

the same name, holding only the documents you’ve selected. 



    Saving the current session as a project

 Start of    topic      
 More options...

1 Click .
2 Display the Projects tab
3 Click Save Session
4 Accept or modify the suggested project name
5 Click OK

This creates a project file, holding all currently open documents, allowing you to reload these documents in any future
Word session. By default, Session Projects are stored under the name “Session”, followed by a date and time 
identifier. When prompted, you can change the name of the Session project. 

{button ,JI(`>BackInfo',`IDH_HOWTO_PROJECTNAME')}    What is a valid project name?



    Automatically saving and restoring sessions

 Start of    topic      
 More options...

MegaWord can automatically save your currently open documents as a Session when you exit Word, and reopen 
those documents the next time you start Word. This project is stored under the default name “Last Session”. To 
enable this feature, do the following:

1 Click .
2 Display the Auto Session tab
3 Select the appropriate options 
4 Click Confirm



    Project names and location

MegaWord Project Manager makes full use of the long filename feature of Windows 95 and Windows NT. Each 
project file can be stored under a name of up to 255 characters long. You can use any combination of uppercase and 
lowercase characters, and spaces. The following characters cannot be used: < > : ” / \ | . Characters with an ANSI 
value between 0 and 31 (such as tabs) cannot be used either. If you specify a project name with one or more illegal 
characters, Project Manager will display a warning.

All projects are automatically saved in a “Projects” subfolder of your WinWord folder, and have the filename extension
“.pro”. If the extension “.pro” is already reserved by another application, Project Manager will use the extension “.dop”
(for DOcument Project), or “.mwp” (for MegaWord Project). Files with the .pro extension in the Projects folder are tiny 
text files that hold information about the location of the individual files in a project. It is not recommended to make 
manual adjustments to these files.



    What do you want to know?

How to:
{button ,JI(`>HowTo',`IDH_HOWTO_OPENPRINT_PROJECT')} Open or print a project
{button ,JI(`>HowTo',`IDH_HOWTO_OPENPRINTDOC_PROJECT')} Open or print a single project document
{button ,JI(`>HowTo',`IDH_HOWTO_RENAMEDELETE_PROJECT')} Rename or delete a project
{button ,JI(`>HowTo',`IDH_HOWTO_ADDDOC_PROJECT')} Add the current document to a project
{button ,JI(`>HowTo',`IDH_HOWTO_MODIFY_PROJECT')} Modify a project
{button ,JI(`>HowTo',`IDH_HOWTO_SESSION_PROJECT')} Save the current session as a project



    Document Recall

    Options...

MegaWord Document Recall never forgets the documents, templates and folders you have worked with.
Reload any document you have worked on in the past, no matter where it’s located. 
Reuse any template you have previously applied to a new document, no matter how long ago.
Open or save a file in any folder you have recently accessed, without endless browsing.

MegaWord 95 uses shortcuts to keep track of documents, templates and folders you have used, and gives you 
instant access to them in a few button clicks.

{button ,JI(`>BackInfo',`IDH_HOWTO_SHORTCUTWHAT')} What exactly is a shortcut?

{button ,KL(`Document Recall')} How do I work with Document Recall?



    Setting up Document Recall

 Start of    topic      
 More options...

Since Document Recall works silently in the background, you don’t have to individually start these applications.

To activate or deactivate Document Recall, choose Document Recall from the Mega menu and confirm your 
preferences. The Setup dialog box offers your options from three tabs. Click OK to confirm your preferences. 

Document Recall tab.
To specify if, and how, you want to work with Document Recall, select your option    from the listbox. 
In the textbox, specify the name you want to give to the subfolder under your “Favorites” folder which will 

hold your document shortcuts. The default name is “Recent Documents”. If a folder with the specified name doesn’t 
exist, it will be created when the first shortcut is created.

In the "Maximum number of shortcuts" box, specify how many documents you want Document Recall to 
"remember". The maximum number is 26.

Template Recall tab.
To specify if, and how, you want to work with Template Recall, select your option    from the listbox. 
In the textbox, specify the name you want to give to the tab in the File/New dialog box which will hold your 

template shortcuts. The default name is “Recent Templates”. If a tab with the specified name doesn’t exist, it will be 
created when the first shortcut is created.

In the "Maximum number of shortcuts" box, specify how many templates you want Template Recall to 
"remember". The maximum number is 26.

Folder Recall tab.
To specify if, and how, you want to work with Folder Recall, select your option    from the listbox. 
In the "Maximum number of shortcuts" box, specify how many documents you want Folder Recall to 

"remember". The maximum number is 26.



    Reopening a recent document

 Start of    topic      
 More options...

Document Recall stores shortcuts to your recent documents in a “Recent Documents” subfolder of your “Favorites” 
folder. To reopen a document you have worked on in the past, do the following:

1 Click .
2 Click .
3 Click the “Recent Documents” folder
4 Double-click the document you want to open



    Reusing a recent template

 Start of    topic      
 More options...

Document Recall stores shortcuts to your recent templates in a “Recently Used” subfolder of your “Templates” folder. 
They appear together under a dedicated "Recently Used" tab in the File/New dialog box. To reuse a template with 
which you have created a recent document, do the following:

1 Choose New from the File menu
2 Click the “Recently Used” tab
3 Double-click the tempate you want to use to create a new document



    Re-accessing a recent folder

 Start of    topic      
 More options...

Document Recall stores shortcuts to folders in which you have recently opened or saved files in your "Favorites" 
folder. To open or save a file in the same folder, do the following:

1 Click .or 
.

2 Click .
3 Double-click the folder you want to open



    Managing Document Recall shortcuts

 Start of    topic      
 More options...

Document Recall has an "auto-cleanup" feature. When you set up Document Recall, you can specify how many 
documents, templates and folders Document Recall should "remember". The maximum number in each category is 
26, but to avoid too much clutter in Word's dialog boxes, you will probably want to limit the number of shortcuts to 
around 15. Once Document Recall has created the specified maximum number of shortcuts in a category, the most 
recent shortcut is added to the top of the list and the oldest shortcut is automatically deleted. 

It is not recommended to delete shortcuts manually.



    MultiPrint

    Options...

MegaWord MultiPrint is designed to give you total control over your print jobs. The macro is especially useful if you 
send faxes or email messages from your computer, because MultiPrint lets you print, fax and/or email a document in 
a single command. The MultiPrint dialog box offers a host of options and features that you won’t find in Word’s own 
Print dialog box, including AutoFax, AutoSpell, and PrintStats.

Setting up MultiPrint
The first time you use MultiPrint, you must set up the application
{button ,JI(`>HowTo',`IDH_HOWTO_SETUP_MP')}How to set up MultiPrint 

Running MultiPrint
MegaWord MultiPrint replaces the original Word Print command. There are three ways to run MultiPrint:

To display the MultiPrint dialog box, click 
.

To display Word’s own Print dialog box, hold down SHIFT and click 
.

To bypass any dialog boxes and print the current document using the current printer settings,    hold down 
CTRL and click 
.

{button ,KL(`MultiPrint')} How do I work with MultiPrint?



    Initializing MultiPrint

 Start of    topic      
 More options...

Before you can work with MultiPrint you must specify the printer drivers you want to use to print and fax your 
documents. Follow these steps:

1 Click .
2 Display the Setup tab 
3 Set your preferences (click the buttons below for details)
4 Click OK to confirm your choices and return to the Print tab. 

{button ,JI(`>HowTo',`IDH_HOWTO_SELECT_MP')} Selecting your default printer and fax 
{button ,JI(`>HowTo',`IDH_HOWTO_AUTOFAX_MP')} Setting AutoFax preferences
{button ,JI(`>HowTo',`IDH_HOWTO_AUTOSPELL_MP')} Setting AutoSpell preferences



    Selecting your default printer and fax 

 Start of    topic      
 More options...

In the Default Printer and Fax group, select your default printer, and your default fax. If you use Microsoft Exchange 
to send your faxes, you can select “Electronic Mail” as your default fax device. This gives you the flexibility to send a 
document either by mail, fax, or both from Exchange. 

Check the "Reset Word to Default Printer after each Print Job” box to force Word to always use your default 
printer. If you leave the box unchecked, Word will continue to see the last printer you used as the default printer, 
which can be awkward after you’ve faxed a document, and want hard copies of all subsequent documents.



    Setting AutoFax preferences

 Start of    topic      
 More options...

MultiPrint can send fax messages immediately to your fax device rather than a printer. The effect is that the MultiPrint
dialog box suggests your fax device as the primary destination, and that clicking  on the Standard toolbar does not
immediately print a hardcopy of the document, but prompts you to specify the destination. To set your AutoFax 
options, do the following:

1 Click .
2 Display the Setup tab 
3 Set your preferences, as described below
4 Click OK to confirm your choices and return to the Print tab. 

AutoFax settings
To enable Autofax, check the “Enable AutoFax” box. 

You must also specify how MegaWord can determine which documents are fax messages. The options are:

Document Template name holds the string xxx. Specify the text you want to use for “xxx”. If you specify 
“FAX”, MegaWord will identify a document as a fax messages if the template name it is based on holds the string 
“FAX” (e.g. CONTEMPORARY FAX.DOT, or FAX WIZARD.WIZ ).

Document Name or Path holds the string XXX. Specify the text you want to use for “xxx”. If you specify 
"FAX", MegaWord will identify a document as a fax message if the name of the document holds the string “FAX” (eg. 
FAX TO HEADOFFICE.DOC) or if the document is saved in a folder that holds the string “FAX” (e.g. C:\MSOFFICE\
WINWORD\FAXES\)



    Setting AutoSpell preferences

 Start of    topic      
 More options...

MultiPrint offers the option to detect if a document holds spelling errors, and can automatically start the spell checker 
before you print a document. This ensures that no letter or report leaves your desk with embarrassing spelling 
mistakes. To set your AutoFax options, do the following:

1 Click .
2 Display the Setup tab 
3 Set your preferences, as described below
4 Click OK to confirm your choices and return to the Print tab. 

Select one of the three options in the “AutoSpell Options” group.
Never check spelling before printing. Documents are always printed, even if they hold spelling errors.
Warn if document holds misspellings. MultiPrint will warn you if the document holds spelling errors or if 

automatic spellchecking is turned off. You have the option to run the spellchecker or print without spellcheck.
Always check spelling before printing. MegaWord automatically starts the spellchecker before displaying 

the MultiPrint dialog box.



    Printing, faxing, or mailing a document

 Start of    topic      
 More options...

1 Click .
2 Display the Print tab 
3 Accept or modify the default settings
4 Click OK 

Many options in MultiPrint are the same as in Word’s own dialog box, but MegaWord offers a host of additonal 
options.

Standard features are:
Number of Pages to Print. Click 

 and 
 to increment or decrement the value. Check the "Collate" box to let Word print a complete copy of the first 

document before it begins to print the first page of the second document.
In the “Print What” list, select Document, Summary Info, Annotations, Styles, AutoText entries, or 

Key assignments
Odd and/or even pages. Select these standard options in the “Print:” listbox



    Dual Destination and Print Fast features

 Start of    topic      
 More options...

From the Print tab you can send your document to one or two destinations in a single command, e.g. to a 
local and network printer, to a printer and a fax device, or to a printer and your email application. Select your primary 
destination in the “First:” list, and optionally your second destination in the “Then:” list. 

If you select “Electronic mail” as one of the destinations, a “Mail as Attachment” box is displayed. Check this 
box to send the current document as an attachment to your email message, leave the box unchecked to send the 
plain text of the document as your email message.

Check the "Print To File" box to print the document to a new file instead of routing it directly to a printer. 
Choose this option to print from a computer that does not have Word for Windows installed, or if you want to print to a
printer other than the one for which you originally created the document. When you choose the OK button, Word 
displays a dialog in which you can select a target drive and directory, and type a new filename. 

Check the “Print Fast” box to disable background printing. This speeds up the printing process, but may slow
down your other word-processing activities.



    Setting page range options

 Start of    topic      
 More options...

The “Page Range” group offers more options than Word’s own Print dialog box.
All. Prints the entire document. The total number of pages is listed, allowing you to fill the printer with 

enough paper to finish the job. 
Current Page. Print only the page containing the insertion point or selection. You can browse through the 

document and select individual pages you want to print, by clicking 
 and 
. The current page number is listed in front of these buttons.

Selection. Print only the selected text, object or graphic
From and To. Prints a contiguous range of pages. To print a range from the first page to a specified page, 

only fill in the "To" box. To print a range from a specified page to the last page, only fill in the "From" box.
Range. Print a non-contiguous range of pages. Type the page numbers separated by commas, or a range of

pages with a hyphen between the page numbers. For example, to print pages 2, 4, 5, 6, and 8, type 2,4-6,8. 
To print an envelope that is attached to the beginning of a document, include 0 (zero) as one of the pages in the 
range.

Envelope only. Prints only the envelope included in the document. This option has the same effect as 
specifying 0 (zero) in the Range: box. If the document doesn’t contain an envelope (which must be created with 
Word's envelope feature), this option is not available. 



    Changing the size and appearance of the document

 Start of    topic      
 More options...

The “Page Range” group holds two buttons that let you change the size or appearance of the printed document.

Click "Page Setup" to make temporary or permanent changes to the page settings of the document. This 
allows you to modify the margins, paper size and layout of the document before you print it. After you’ve made your 
Page Setup settings you are prompted whether you want to make these changes permanent, or want them only used
for the current print job. If you only want to use the settings for the current print job, MegaWord will restore the original
Page Setup settings after the document is printed.

Click "Shrink Doc" if the last page of the document holds very little text. Word will then try to shrink the 
fontsize and margins of the document to squeeze the contents into one less page.



    Printing one, more or all documents

 Start of    topic      
 More options...

The “Document to Print” group lists the current document by default. If more than one document is currently open, 
you can select any other document from the list. Select the “All documents” option to print all currently open 
documents. 

If you select this option, the “Page Range” group will default to “All”. 
The "All Documents" option is not available if Electronic mail is one of your destinations.



    Specifying temporary print options

 Start of    topic      
 More options...

In the MultiPrint dialog box, select the Options tab to specify additional print options. Unlike in Word’s Print Options 
dialog box, all choices you make apply to the current print job only, without affecting future print jobs. You can now 
print hidden text in the current document, without printing hidden text in another document, or print all even pages in 
reverse order and use the normal page order for the next print job. 

The “Options” tab offers two options you don’t find in Word’s Options dialog: "Revisions" and "Highlights". Both 
settings are only applied to the current print job; the original settings are restored after the document has been sent to
the printer.

The “Revisions” option lets you include or exclude revisions for the current print job

The “Highlights” option allows you to hide the highlights you’ve made in your document while you print. 

Click "Font Substitution" to select fonts available on your system to substitute for those unavailable in the 
current document. 



    Keeping and reading print statistics

 Start of    topic      
 More options...

MultiPrint offers a number of options that give you statistics about your printing activities. These options are available 
from the Statistics tab.

 “Add Print History to document”. Check this box to start building a print history for each document. Each 
time you print a document from the MultiPrint dialog box, information is stored inside the document about the date it 
was printed, the initials of the person who printed it, and the destination of the print job.

Choose "Clear History list" to remove the print statistics. MultiPrint keeps track of up to 500 print jobs. When 
you see that the statistics are not updated anymore, you must delete the print history

Counts. MultiPrint automatically keeps track of the numbers of pages you print and the number of fax messages you 
send. The page count is not fully accurate if you often print only part of a document, but in all other circumstances it 
gives you a reasonably reliable figure. 

Choose "Reset Counter" to set the counts back at zero, and restart counting from the current date.

Note    The Statistics apply only to print jobs started from the MultiPrint dialog box, and from the  button on the 
Standard toolbar. Print jobs started from other Word features (e.g. Mail Merge) are not taken into account



 The Print button on the Standard toolbar

 Start of    topic      
 More options...

If you have enabled the "AutoFax" option in the MultiPrint dialog box, the behavior of the  button on Word's 
Standard toolbar is automatically adjusted.

If the document you want to print is a regular document it will immediately be sent to your default printer.
If the document you want to print is recognized as a fax message, you will be asked whether to send it to 

your fax device or to your default printer.

You can influence the behavior of the Print button by holding down the SHIFT or CTRL key when you click . The 
effect is the following:

SHIFT key down: output always goes to the default printer
CTRL key down: a dialog box is displayed offering you the options to print, fax, or print and fax the document.





    Format Cycler

    Options...

MegaWord Format Cycler lets you quickly cycle through preset formats from a dedicated toolbar. Three of the format 
types are fully configurable.

Running Format Cycler
To display the Cycle Format toolbar, click 

. 
When the Cycle Format toolbar is displayed, click the required button to cycle forward through a range of 

preset formats which are immediately applied to the selection. 
Hold down SHIFT and click to cycle back through the range. 

{button ,KL(`Format Cycler')} How do I use Format Cycler?



    Cycling through preset formats

 Start of    topic    
 More options...

1 Click  to display the Cycle Format toolbar. 
2 Click the following buttons to cycle through preset formats. 
Hold down SHIFT to cycle backwards.

Font. Cycles through six preset fonts. The first time you click this button, the Format Cycler Setup dialog box
is displayed. 
Hold down CTRL and click 
 to change the preset fonts.

Fontstyle. Cycles through all combinations of the bold, italic, smallcaps and allcaps formats.
Fontsize. Cycles through six preset fontsizes. The first time you click this button, the Format Cycler Setup 

dialog box is displayed. 
Hold down CTRL and click 
 to change the preset fontsizes.

Underline. Cycles through the five underline options: none, single, words-only, double and dotted.
Alignment. Cycles through the four paragraph alignment styles: flush left, centered, flush right, and justified.
Style. Cycles through six preset styles. The first time you click this button, the Format Cycler Setup dialog 

box is displayed. This feature is especially useful if you select numbered styles, such as the Heading, Index or TOC 
style 
Hold down CTRL and click 
 to change the preset fonts. 

Bullet. Cycles through Word’s six preset Bullet styles.
Numbering. Cycles through Word’s six preset Numbering styles.
Border. Cycles through eleven preset border styles. If table cells are selected, the border is applied to the 

cells, otherwise the border is placed around the selected paragraph(s).
Background Color. Cycles through 16 background colors. If table cells are selected, the background color 

is applied to the cells, otherwise the background color is applied to the selected paragraph(s).
Shading. Cycles through 25 background shading patterns. If table cells are selected, the shading is applied 

to the cells, otherwise the shading is applied to the selected paragraph(s).
Shading Color. Cycles through 16 shading colors. If table cells are selected, the shading color is applied to 

the cells, otherwise the shading color is applied to the selected paragraph(s).
Cycle Format Setup (the last button on the toolbar). Lets you specify the formats through which you can 

cycle from the Cycle Font, Cycle Fontsize and Cycle Style buttons. 



    Setting up Format Cycler

 Start of    topic    
 More options...

1 Click  to display the Cycle Format toolbar. 
2 Click  to display the Setup dialog box. 
3 Select the required tab:

Font tab. Select the six fonts between which you want to cycle, then click OK to confirm.
Fontsize tab. Accept the proposed fontsizes or type your own preferences. Click OK to confirm.
Style tab. Select the six styles between which you want to cycle, then click OK to confirm.

You can also display the appropriate tab by holding down CTRL and clicking these buttons:
 
 



    Repeat Format

    Options...

With MegaWord Repeat Format you can repeat up to twenty different formats and combinations of formats, 
throughout a document, across documents, and even from one Word session to another. Repeat Format also 
features a unique "Copy by Example" option.

Since Repeat Format works silently in the background, it's important to understand how to take advantage of this 
feature. Click the buttons below to see all your options.

{button ,KL(`Repeat Format')} How do I work with Repeat Format?
{button ,JI(`>BackInfo',`IDH_HOWTO_TRAIN_REPFMT')} Repeat Format exercises
{button ,JI(`>BackInfo',`IDH_HOWTO_NOTES_REPFMT')} Special notes



    How Repeat Format works

 Start of    topic      
 More options...

Each time you choose one of the menu commands listed below, MegaWord remembers the choices you have made, 
and lets you repeat these settings whenever and wherever you want to. Repeat Format keeps tracks of the following 
menu commands:

Menu Formatting command 
Format Font

Paragraph
Tabs
Borders and Shading
Change Case
DropCap
Bullets and Numbering
Style
Frame
Picture

Table Table Autoformat
Cell Height and Width

After Repeat Format has stored the settings for each of these formats in its database, you can apply the same format 
to a different part of the document, or even in a different document, in three ways:

{button ,JI(`>HowTo',`IDH_HOWTO_REPDLG_REPFMT')} Repeating a format from the dialog box
{button ,JI(`>HowTo',`IDH_HOWTO_REPKBD_REPFMT')} Repeating a format with the keyboard
{button ,JI(`>HowTo',`IDH_HOWTO_SHORTCUT_REPFMT')} Repeat Format shortcuts



    Repeating a format from the dialog box

 Start of    topic      
 More options...

1 Click .
2 To repeat a listed format, double click the format in the list (See Note below)
3 If the effect is not what you expected, click Undo before closing the dialog box

Note  The dialog box lists only formats that are valid in the current context (for example: formats that refer to tables 
are only displayed if the insertion point is inside a table). The Repeat Format list can hold the following formats:

· Borders
· Borders and Shading
· Bullets
· Cell Height
· Cell Height and Width
· Cell Width
· Change Case
· Drop Cap
· Font
· Font and Paragraph
· Frame
· Numbering
· Paragraph
· Picture Height
· Picture Scaling
· Picture Width
· Shading
· Style
· Table AutoFormat
· Tabs



    Repeating a format with the keyboard

 Start of    topic      
 More options...

You can instantly repeat a previously applied format, without displaying the dialog box.

1 Hold down CTRL .
2 Select the required formatting option from the Format or Table menu (See Note below)

The previously selected format is immediately applied to the selection.

Example: To repeat the last applied Font format, hold CTRL, and select Font from the Format menu. In stead of 
displaying the Font dialog box, Repeat Format applies the most recently applied Font format to the selected text. 

Note The following table explains which formats are repeated if you use the method described above:

Format menu Command Repeat Last:
Font Font format
Paragraph Paragraph format
Tabs Tab settings
Borders and Shading Borders and shading
Change Case Case setting
Drop Cap Dropcap format
Bullets Bullet format
Numbering Number format
Style Style
Frame Frame format
Picture Picture scaling only

Table menu Command Repeat Last:
Table AutoFormat AutoFormat settings
Cell Height and Width Both Cell Height and Width

    Repeat Format shortcuts

 Start of    topic      
 More options...

Repeat Format offers three shortcuts to apply the last Font, Paragraph or any last format. 

Hold down SHIFT and click 
 to repeat the last Font format

Hold down CTRL and click 
 to repeat the last Paragraph format

Hold down SHIFT+CTRL and click 
 to repeat any last format



    Copying a format “by example” 

 Start of    topic      
 More options...

Repeat Format offers a unique "copy by example" method to copy a format from one location in a document to 
another, or even to different documents. Follow these steps:

1 Place the insertion point in the text, table, frame or picture of which you want to copy the format. 
2 Select the appropriate command from the Format or Table menu, and hold down the SHIFT key while you choose 
the command. 
For example: to copy the last applied font, hold down the SHIFT key, and select Font from the Format menu. 
While you do this, the associated dialog box is not displayed, but Repeat Format stores the format in its database.

3 Move the insertion point to the location where you want to copy the format. Select text if appropriate.
4 Hold down CTRL+SHIFT and click . The format is immediately applied to the selection.
5 Repeat steps 3 and 4 as often as necessary to apply the selected format to other parts of the document, or 
any other document.

You can copy all formats listed below. (Note that you can't copy Bullets, Numbers and Change Case settings.) The 
following table explains which formats are copied if you use this method:

Format Menu Format Copied:
Font Font format
Paragraph Paragraph format
Tabs Tab settings
Borders and Shading Borders and shading
Drop Cap Dropcap format
Style Style
Frame Frame format
Picture Picture scaling only

Table Menu Format Copied:
Table AutoFormat AutoFormat settings
Cell Height and Width Both Cell Height and Width

    Repeat Format exercises

 Start of    topic      
 More options...

Repeat Format is easy to use once you know the tricks. To give you an idea of how Repeat Format works, try the 
following exercises:

Exercise 1: How to give a number of different pictures the same height
1 Open a new empty document
2 Choose Picture from the Insert menu
3 Insert three or four pictures from the CLIPART folder
4 Select the first picture
5 Choose Picture from the Format menu
6 Set the picture height at 1 inch. Before you close the dialog box, set the Scaling Width at the same value as the 
Scaling Height. This will automatically resize the picture width.

7 Close the dialog box
8 Now select the following picture
9 Hold down CTRL+SHIFT and click the Repeat Format button. The picture will now have the same height as the first
one:

10 Repeat steps 8 and 9 until you've resized all pictures

Exercise 2: How to apply the Title Case format to all paragraphs formatted as Heading 1
1 Go the start of a document that holds multiple paragraphs with the Heading 1 style
2 Choose Find from the Edit menu



3 In the dialog box, clear the "Find What" box and click the No Formatting button
4 Choose the Format button
5 Select Style from the menu
6 Select "Heading 1" in the list of styles
7 Choose the Find Next button
8 Close the dialog box
9 Choose Change Case from the Format menu
10 Select "Title Case" and click OK
11 Press SHIFT+F4 to find the next paragraph with the Heading 1 style
12 Hold down CTRL+SHIFT and click the Repeat Format button. Each word in the paragraph will now have an initial 
uppercase

13 Repeat steps 11 and 12 until you've reached the end of the document

Exercise 3: How to create identical frames (e.g. sidebars) throughout a document
1 Make sure the document is displayed in Page Layout View
2 Select the text you want to place in a frame
3 Choose Frame from the Insert menu
4 Choose Frame from the Format menu
5 Specify exact sizes for the width and height of the frame
6 Specify the appropriate values for the horizontal and vertical position
7 Choose OK
8 Select the next text you want to insert in a frame of the same size
9 Hold down CTRL+SHIFT and click the Repeat Format button. The selected text is immediately framed, and the 
frame is formatted as the previous one.

10 Repeat steps 8 and 9 for any other text you want to frame

Exercise 4: How to give multiple tables the same format
1 Place the insertion point inside a table
2 Choose Table AutoFormat from the Table menu
3 Specify the AutoFormat settings in the dialog box
4 Choose OK to confirm
5 Press F5 and select Table, then choose Next, then Close
6 Hold down CTRL+SHIFT and click the Repeat Format button. The table is immediately formatted as the previous 
one

7 Press SHIFT+F4 to find the next table
8 Repeat steps 6 and 7 until no further tables are found



    Special notes

 Start of    topic      
 More options...

To create the Repeat Format application we had to modify a large number of Word's existing formatting commands. 
In most cases this could be done with impunity; Word is built that way (thanks Microsoft!). But in some cases Word 
wasn't that flexible, so we had to make a few concessions when we rewrote the commands Bullets and Numbering 
(Format menu) and Cell Height and Width (Table menu). This has some side effects that you may appreciate or not. 
The following describes what to do if you want to restore the original commands on the menus:

Restoring the original Bullets and Numbering command on the Format menu
Since we had to modify Word's Bullets and Numbering (Format menu) command, we were forced to drop the 
"MultiLevel" tab in the Bullets and Numbering dialog box. (Don’t blame us; it’s a Word bug.) This means that you can't
apply MultiLevel numbering from the Format menu anymore. If you use this feature only occasionally, you can display
the original dialog box (including the MultiLevel tab) in the following way:
1 Choose Macro from the Tools menu
2 In the "Macros available in" list, select "Word commands"
3 In the "Macro name" list select "ToolsBulletsAndNumbering" (or the equivalent in your language)
4 Click Run (or the equivalent in your language)

If you use the MultiLevel feature very often, you can remove the MegaWord version from the Format menu, and re-
install the original command. This means that you cannot use Repeat Format for this command anymore! These are 
the steps:
1 Open !MEGA_95.DOT from the Startup folder, and make it the active document
2 Choose Macro from the Tools menu
3 In the dialog box, select "FormatBulletsAndNumbering" (or the equivalent in your language)
4 Click Delete, and confirm your decision
5 Close the dialog box
6 Close !MEGA_95.DOT and confirm changes

Restoring the original Cell Height and Width command on the Table menu
I you run a non-English version of Word, you may see an English command name where there was a command in 
your own language before you installed MegaWord. If you want to change the name on the menus, do the following:
1 Open !MEGA_95.DOT from the Startup folder, and make it the active document
2 Choose Customize from the Tools menu
3 Select the "Menus" tab
4 In the "Categories" list, select "Macros"
5 In the "Macros" list, select "TableFormatCells"
6 In the "Change What Menu" list, select "Table" (or the equivalent in your language)
7 In the "Name on Menu" box, type the command name in your own language
8 Click Rename 
9 Close the dialog box
10 Close !MEGA_95.DOT and confirm changes



    Font Manager

 Options...

MegaWord Font Manager helps you find your way in your ever growing font collection. You can assign meaningful 
names to groups of related fonts and apply any shortlisted font to your documents from a dialog box. It is entirely up 
to you how you want to organize your fonts. You can create font groups that separate your business fonts from your 
fancy fonts, organize your decorative and symbol fonts in individual groups, or make font groups that reflect the type 
of document (letters, contracts, publications, etc.) you want to create. A font can appear in more than one font group, 
and both the number of font groups as the number of fonts in each group is unlimited.

Font Manager also lets you print Font Charts in four different styles.

Running Font Manager
To display the Font Manager dialog box, click 

. 
If you want to apply a font to text in your document, you must select the text before you run Font Manager. 

{button ,KL(`Font Manager')} How do I work with Font Manager?



    Finding, previewing and applying fonts
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1 Click  to display the Font Manager dialog box, or
Hold down CTRL and Click  to display the Font Manager Organizer.

2 In the Font Group list, select the group that holds the type of font you want to apply, or click Show All to 
display a list of all fonts that are installed on your system.
3 In the Fonts in this Group list, select the font you want to apply
4 Check to see if the preview box shows the font you are looking for (see Notes 1 and 2 below)
5 Click Apply Now, or double click the font in the list.

Note 1    If text is selected in the document, the preview box shows up to 255 characters of the selected text, 
otherwise the preview displays a sample text. Unlike Word's own font preview boxes, Font Manager also lets you edit 
the text in the preview. Just place the insertion point in the preview box, delete the existing text, and type your own.

Note 2    In the Font Manager Organizer dialog box, you can click Zoom In to display the font in approx. 48 pts size. 
To see more of the sample text than is currently visible, place the cursor in the box and use the cursor keys to move 
through the sample text. To return to the default preview size, click Zoom Out



    Creating and managing font groups
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Display the Font Manager Organizer dialog box in one of these ways:
If the Font Manager dialog box is displayed, click Organizer
Otherwise, hold down CTRL and click 

.

Select the Group tab to create, modify or delete font groups. The topmost list on the right displays your Font Groups. 
The list below it displays the fonts that are assigned to that group. The first time you run Font Manager, a sample 
"Arial Family" font group is automatically created. You can later rename, update or delete this group if you wish.

How to create a font group
To create a new Font Group, do the following:
1 Click New Group
2 Type the name of the Font Group
3 Select any font from the Windows FontBank list (on the left) and click Add to add the selected font to your Font 
Group

4 To remove a font from a group, select the font in the "Fonts in this Group" list. Click Remove to put the font back in
the FontBank. 

5 If you want to add many fonts to a group, you can first click Add All and then remove the fonts you don't want to 
include. 

6 To clear the list of selected fonts, place your cursor in the list and click Clear All. 
7 When you have created your group, click Save Group 

How to modify a font group
You can at any time add new fonts to a group, or remove fonts from it. 
1 Select in the Font Group list the group you want to modify, then add or remove fonts. 
2 Click Save Group to store the new contents of the group.

How to rename a font group
If you want to change the name of a Font Group:
1 Select the group in the Font Group list. 
2 Click Rename Group and type a new name. 
3 Click Save Group to confirm the new name.

How to delete a font group
To delete a Font Group, select that group in the Font Group list, and click Delete Group. After your 

confirmation the group will be permanently deleted.



    Creating Font Charts
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Display the Font Manager Organizer dialog box in one of these ways:
If the Font Manager dialog box is displayed, click Organizer
Otherwise, hold down CTRL and click 

.

Choose the Charts tab to create Font Charts that you can later print, and use as a reference. Font Manager can 
create Font Charts in four different types:

Font Inventory. A list of all installed fonts, and every character in each font. 
Sample Sheet. A demonstration of the formatting capabilities of a specific font. The Sample Sheet shows 

the font in different formats and sizes, in Dropcaps and multi-column text.
ANSI Chart. A list of all characters in a font, and their associated ANSI value. 
Keyboard Table. A list of all characters in a font, specifically for use with fonts that don't hold alphanumeric 

characters, such as Symbol and WingDings. With the help of a Keyboard Table you can find out which character on 
your keyboard must be used to generate a specific symbol. 

Font Chart Options
When you create a Font Chart, the following options are available:

"Create Chart for All Fonts". With this box checked, Font Manager will create the selected Font Chart for all 
fonts installed on your system. Since this can be a lengthy process, make sure that you can do without your computer
for a while.

"Use Preview box Contents as Sample Text". By default, Font Manager use a standard text for the Font 
Chart samples. To use a sample text of your own, type the text in the preview box, and activate this option.

Choose Create Chart to confirm your choice and create the chart



Another breakthrough in WordBasic programming! The undocumented technique to display a Font Preview in a Word
dialog box is discussed in an article written by the maker of MegaWord, in Windows Tech Journal, Volume 4, Number 
4 (April 1995).



    Surround Selection
MegaWord Surround Selection offers the easy way to place text between matching pairs of quotes, brackets, dashes,
and other typographical symbols.

Running Surround Selection
1 Select the text you want to enclose in typographical characters. If you want to surround a single word, place the 
insertion point in that word. 

2 Click  to display the Surround Selection dialog box, which offers 18 character pairs that you can apply to the 
selected text. When you click a button, the characters are immediately placed around the selection. 

3 To adjust the selection and apply the surrounding characters to the current sentence or paragraph, make 
your choice from the listbox. (Note: once you have selected a sentence or paragraph, you can’t restore the original 
selection.)
4 To apply more than one pair of surrounding characters, click the same button again, or click a different one. 
5 If the result is not what you expected, click Undo.

Repeating a Surrounding
Surround Selection remembers the last character pair you have applied. 

Hold down CTRL and click 
 to repeat the same surrounding to other text in any document.



    Special Characters

    Options...

MegaWord Special Characters gives you the intelligent tool to insert special characters in your document. No need to
remember dozens of shortcut keys: one hotkey does it all.

Running Special Characters
Special Characters is designed to replace Word’s Insert Symbol command. To display the Special Characters dialog 
box:
1 Type a character for which you need an accented version or look-alike, or place the insertion to the right of an 
existing character

2 Do one of the following:
Click 

Press ALT+F3
Choose Symbol from the Insert menu

The list at the left holds a range of base characters. If the character at the left of the insertion point is one of these 
base characters (e.g. “a”), the dialog box shows a row of buttons with alternatives (àáâäãåæ, etc.). You can select 
any character from the list to display alternatives for that character in the button row. 

To replace the character in the document with an alternative character, click the appropriate button. 
To insert more than one character, hold down SHIFT and click a button. 

Hint    Unlike Word’s own Insert Symbol command, the MegaWord replacement also works in a macro window. To 
insert special characters in a macro listing, click .



    Displaying Word’s Symbol dialog box
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To display Word’s built-in Symbol dialog box, do one of the following:

If the Special Character dialog box is displayed, click “S”
If not, hold down SHIFT and click .



    Running the Windows Character Map
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The Windows Character Map lets you create strings of special characters or symbol which you can copy to the 
Clipboard and then paste in your document. 

To run the Character Map, display the Special Character dialog box, then click “M”. 



    Repeating a special character
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Each time you insert a character, Special Characters stores it in a database. To quickly repeat the last symbol or 
special character you inserted, without displaying the dialog box, do the following:

Hold down CTRL and click  
.

You can repeat this action as often as you like, even in other documents or during your next Word session.



    3D Tables

 Options...
MegaWord 3D Tables lets you add spectacular 3D Effects to entire tables or selected table cells, and preview the 
effect before you apply them.

Running 3D Tables 
To apply 3D effects to an entire table, place the insertion point anywhere in the table.
To apply 3D effects to selected cells, select the cells before you run the macro. 

To run MegaWord 3D Tables, do one of the following:
Choose 3D Effects from the Table menu
Right-click in a table and choose 3D Effects from the menu
Click 

 on the Tables toolbar.

{button ,KL(`Table 3D Effects')} How to apply 3D effects



    Applying 3D effects to an entire table
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To apply 3D effects to an entire table, do the following:

1 Place the insertion point anywhere in the table
2 Display the MegaWord Table 3D dialog box
3 Select the Table tab. 
4 Select the required Effect and Contrast
5 Click Apply. 

The table will immediately take the chosen 3D effect.

To remove the effect:
Click All White to remove all borders and background effects.
Click All Gray to remove all borders and leave the table entirely gray. 



    Applying 3D effects to selected cells
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Applying 3D effects to selected cells requires two sets of steps. If you haven’t done so yet, you must first apply a gray
shading to the entire table. This takes the following steps:
1 Display the MegaWord Table 3D dialog box
2 Select the Table tab. 
3 Click All Gray. If the table doesn’t become entirely gray, click first All White, then All Gray.
4 Close the dialog box

Once    the “All Gray” format has been applied, do the following:
1 Select the cells to which you want to give a 3D effect,
2 Display the MegaWord Table 3D dialog box
3 Select the Cells tab. 
4 Select the desired Effect and Contrast
5 Click Apply. 

The selected cells will immediately take the chosen 3D effect. 

To remove the effect:
Click All White to remove all borders and background effects from the selected cells.
Click All Gray to remove all borders and leave the selected cells entirely gray.



    Table AutoFill™

 Options...

MegaWord AutoFill brings Excel's AutoFill feature to your WinWord tables - and more. Filling a row, column or a 
group of cells with incremental date, time and numeric values now becomes an easy point and click operation. And 
when you have created a list that you want to use more often, AutoFill saves it for you and lets you recreate it any 
time in the future.

Before you run MegaWord AutoFill
Place the insertion point in a table. If you want AutoFill to work on a selected range of cells (in the same row 

or column), select the cells before you run the macro. 

To display the AutoFill dialog box, do one of the following:
Choose AutoFill from the Table menu
Right-click in a table and choose AutoFill from the menu
Click 

 on the Tables toolbar.

{button ,KL(`Table AutoFill')} How do I work with Table AutoFill?



    Defining the cell range
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{button ,JI(`>HowTo',`IDH_TableFill_CNT')} How to display the AutoFill dialog box 

In the "Apply from First selected Cell to:" list, specify the cell range on which you want AutoFill to work. The options 
are:

End of Row - the action applies to all cells from the (first) selected cell to the end of the row.
End of Column - the action applies to all cells from the (first) selected cell to the end of the column.
Last selected cell in Row - the action applies to all cells from the first selected cell to the last selected cell 

in the same row.
Last selected cell in Column - the action applies to all cells from the first selected cell to the last selected 

cell in the same column.
AutoFill makes an assumption of the range you want to fill, based on the currently selected cells. A prompt just below 
the list translates your choice into actual row and column ranges, and tells you how many cells are available in the 
specified range. If only one cell is available (which means that no range filling is possible), the OK button is disabled.



    Formatting date, time and number ranges
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{button ,JI(`>HowTo',`IDH_TableFill_CNT')} How to display the AutoFill dialog box 

From the Date, Time and Number tabs you can specify a Prefix or Suffix, select a Language, and specify the Case of 
the text that AutoFill will use when filling the range. 

Prefix - text to be added in front of the date, time or number. Example: you can choose year values from 
1994 to 2000, and specify "Forecast" as the prefix, which gives you a range like "Forecast 1994, Forecast 1995,.."

Suffix - text to be added after the date, time or number. Example: you can choose ordinal numbers in the 
range 1 to 4, and specify "Quarter" as the suffix, which gives you a range like "First Quarter, Second Quarter, ..."

Language - for dates, times and numbers that Word can translate, you can select the language from this 
listbox. Example: specifying numbers in the range 1 to 10 as literal text in French, will give you a range like "un, deux,
trois,    .."

Case - lets you specify the use of uppercase and lowercase characters in the range. The options are As 
Specified, all lowercase, ALL UPPERCASE and Each First Character. Choosing As Specified (the default), will leave 
the case unchanged.



    Creating date ranges

 Start of    topic      
 More options...

{button ,JI(`>HowTo',`IDH_TableFill_CNT')} How to display the AutoFill dialog box 
Activate the Date tab to fill a range of cells with incremental dates

1 In the Start Date box, specify the first date in the range. If the first cell in the selection contains a date string, 
it is displayed by default, otherwise the current date is the default start date. To change the start date, type in the Start
Date box the date that will appear in the first cell. You can use any format; AutoFill will recognize dates like "9/9/94", 
"9/94", "Sep 94", "1994", etc. 
2 In the Date Format box, specify the format in which the date is inserted. If you are familiar with Word's date 
formats, you can type the format here, otherwise you can select a predefined date format from the list. AutoFill 
translates your choice into a valid Word date format. The next time you use AutoFill, your last date format will be 
listed as the default.

3 In the Date Unit box, select one of the four available units, and specify the increment. For example: to create a 
date range in weekly increments, select Week as the Date Unit, and specify 1 as the Step Value. To create a 
range of quarterly dates, select Month as the Date Unit, and specify 3 as the Step Value. You can specify a 
negative step value to create a decremental range.

4 Click OK 



    Creating time ranges
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{button ,JI(`>HowTo',`IDH_TableFill_CNT')} How to display the AutoFill dialog box 
Activate the Time tab to fill a range of cells with incremental times

1 In the Start Time, specify the first time value in the range. If the first cell in the selection contains a time 
string, it is displayed by default, otherwise the current time is the default start time. To change the start time, type in 
the Start Time box the time that will appear in the first cell. You can use any format; AutoFill will recognize times like 
"11:10 am", "23", "1200", etc. 
2 In the Date Format box, specify the format in which the time is inserted. If you are familiar with Word's time 
formats, you can type the format here, otherwise you can select a predefined time format from the list. AutoFill 
translates your choice into a valid Word time format. The next time you use AutoFill, your last time format will be 
listed as the default.

3 In the Time Unit box, select one of the three available units, and specify the increment. For example: to create a 
time range in hourly increments, select Hour as the Time Unit, and specify 1 as the Step Value. To create a range 
in 15 minute increments, select Minute as the Time Unit, and specify 15 as the Step Value. You can specify a 
negative step value to create a decremental range. You can also use fractions for the Step Value. Example: if you 
select Hour as the Time Unit, and 0.5 as the Step Value, you'll get a range in half hour increments.

4 Click OK 



    Creating number ranges
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{button ,JI(`>HowTo',`IDH_TableFill_CNT')} How to display the AutoFill dialog box 
Activate the Number tab to fill a range of cells with incremental numbers.

From the Number tab you can fill a range of cells with incremental numbers, in any format recognized by Word. 
1 In the Start Value box, specify the first value in the range. If the first cell in the selection contains a numeric string, 
it is displayed as the default start value, otherwise zero will be the initial start value. To change the start number, 
type in the Start Value box the number that will appear in the first cell. Start values may be negative numbers and 
have decimal fractions.

2 In the Number Format box, specify the format in which the number is inserted. If you are familiar with Word's 
number formats, you can type the format here, otherwise you can select a predefined number format from the list. 
AutoFill translates your choice into a valid Word number format. (Choosing "Alphabetic" as the number format will 
create a range of letters, whereby A equals 1, B equals 2, etc.) 

3 In the Number Type group, select one of the two available units, and specify the increments. The Linear option 
creates simple increments, like 1, 2, 3. You can specify a negative step value to create a decremental range. The 
Growth option creates ranges in which each value is the previous value multiplied by the step value, e.g. if the 
Start Value is 1 and the Step Value is 2, your range will be 1, 2, 4, 8, 16, etc. If you choose the Growth option with 
a Step Value of 1, all numbers in the range will be the same as the number in the first cell. Step Values may be 
negative numbers and have decimal fractions.

4 Click OK 



    Working with custom lists
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{button ,JI(`>HowTo',`IDH_TableFill_CNT')} How to display the AutoFill dialog box 
Activate the List tab to fill a range of cells with a series of text strings you use often, e.g. the names of your 

staff, a list of goods, or a range like "North", "East", "South", "West", "Total". From the same tab you can also create 
new ranges, modify existing ranges, or import a range from the active table, and store it as a list for future use.

If the first selected cell in the table is recognized by AutoFill as the first entry of a Custom List, the dialog box will 
immediately come up with the Custom Lists tab active, and the full range displayed. 

Click “More options” at the top of this screen to find out how to create, apply, edit, delete and import custom lists



    Creating a custom list
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{button ,JI(`>HowTo',`IDH_TableFill_CNT')} How to display the AutoFill dialog box 

To create a custom list:
1 Select the List tab.
2 Choose NEW LIST. 
3 In the "List Entries" textbox, type your list, separating each entry with a press on the ENTER key.
4 Click Save. 

The list is immediately added to the listbox on the left. Repeat these steps to create as many custom lists as you 
need. 

Notes:
Due to a Word limitation, the total length of all entries in a custom list (including the Enter key presses) 

cannot exceed 255 characters. This means that if you want to create 10 entries in a single list, their average length 
must be around 24 characters. 

When you create custom lists, make sure that each first list entry is unique. If you have a list of all 12 month
names, e.g. "January, February,..., December" you cannot create a list of quarterly month names starting with the 
same first list entry, e.g. "January, April,...". One workaround would be to add a space to the first entry, which makes it
unique. 

List entries may not hold the characters "[", "]" or "=".



    Applying a custom list
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{button ,JI(`>HowTo',`IDH_TableFill_CNT')} How to display the AutoFill dialog box 

To apply a custom list:
1 Select the List tab.
2 In the Custom Lists box, select the appropriate entry to preview the list.
3 Click OK. 

Note:    Make sure that the number of cells in the range is at least equal to the number of custom list entries you want 
to insert. If the number of list entries is higher than the number of available cells, only the list entries that fit in the 
range will be inserted. If the number of list entries is smaller than the number of available cells, all list entries will be 
inserted, leaving the remaining cells unchanged. 



    Shortcuts for applying a custom list
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You can quickly insert a custom list without displaying the dialog box. 

First:
Type the first list entry in the start cell. 

Then:
To create the entire range in the same row, hold down CTRL and run AutoFill.
To create the entire range in the same column, hold down CTRL+SHIFT and run AutoFill.



    Modify a custom list
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{button ,JI(`>HowTo',`IDH_TableFill_CNT')} How to display the AutoFill dialog box 

To modify a custom list:
1 Select the List tab.
2 In the Custom Lists box, select the appropriate entry to display the list.
3 In the List Entries textbox, make the necessary changes
4 Click Save. 



    Deleting a custom list
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{button ,JI(`>HowTo',`IDH_TableFill_CNT')} How to display the AutoFill dialog box 

To delete a custom list:
1 Select the List tab.
2 In the Custom Lists box, select the appropriate entry
3 Click Delete. After your confirmation the list is permanently deleted.



    Importing a custom list
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{button ,JI(`>HowTo',`IDH_TableFill_CNT')} How to display the AutoFill dialog box 

You can easily import a range of list entries from the active table and store it as a Custom List for future use. 

1 Select the range of cells you want to import, or place the insertion point in the first cell of the range. 
2 Run AutoFill 
3 Select the Custom Lists tab. 
4 In the "Import from First selected Cell to:" group, specify the range of cells you want to import 
5 Click Import. All entries in that range will then appear in the "List" text box. 
6 Edit the range if necessary
7 Click Save.



    Duplicating cells
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{button ,JI(`>HowTo',`IDH_TableFill_CNT')} How to display the AutoFill dialog box 

Activate the Duplicate tab to fill a range of cells with the contents or format of the first cell in the range. There
are three options: 

Entire Cell Contents - Duplicate the entire contents (which can be text, or a graphic, or both) of the first cell
in the range across the entire specified range. This is especially a useful feature if you have created a spreadsheet-
like table, in which the last cell of each row or column represents the sum of the cells to the left or above. Use Word's 
Table Formula feature to insert the appropriate formula in the first cell, e.g. =SUM(ABOVE), then use AutoFill to copy 
the formula across the entire row or column. As a bonus AutoFill automatically performs all calculations while the 
range is created.

Char/Para Format - Duplicate the character format and paragraph format of the first cell in the range across
the remainder of the range. The format of the first character defines which format is used for all characters in the 
range. 

Border/Shading - Duplicate the border and shading formats of the first cell in the range across the 
remainder of the range.



    Shortcuts for duplicating cells
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You can quickly copy the contents of a cell across a range of adjacent cells in the same row or column without 
displaying the dialog box. 

1 Select the range of cells, making sure that the cell you want to copy is the first one in the selection. 
2 Hold down SHIFT and run MegaWord AutoFill.



Some number formats can only be applied to a limited range of values. Roman numerals must be positive values in 
the range 1-3999, Alphabetical numbers must be in the range 1-780, text representations of numbers can only be 
used for the range 1-999999. If you specify a range that's not compatible with the format, cells will be filled with 
Error! Number cannot be represented in specified format.



    Table Toolbar
MegaWord gives you the Table toolbar Microsoft forgot. Now you can add and remove cells, add borders and 
shading, sort your tables and make table calculations, all with a click on a button. And, of course, MegaWord Table 
3D and MegaWord AutoFill are also only a mouse-click away.

Displaying the Table Toolbar
To toggle the Table Toolbar on and off, do one of the following:

Choose Table Toolbar from the Table menu
Select the Table Toolbar in the View, Toolbars dialog box. 

When the Table toolbar is displayed, place the cursor on top of an icon for a second to see a textual hint of its 
meaning. (If you don’t see these tool tips, check the “Show Tooltips” box in the View Toolbars dialog box.) For 
additional information, look at the statusbar. 



    FastSort™
MegaWord Fast Sort makes sorting text and tables a snap. No need to display Word’s Sort dialog box when you just 
want a quick alphabetical sort of table rows or paragraphs. MegaWord gives you a Fast Sort dialog box, and two 
shortcuts to instantly sort text the way you want it most of the times.

Running Fast Sort
Before you run Fast Sort, make sure to follow these guidelines:

Sort what? Do this first:
Entire table Place the insertion point in a table,

without selecting anything
Selected table rows Select the rows you want to sort
Entire document Undo any selection 
Selected paragraphs Select the paragraphs you want to

sort

To run Fast Sort, click 
. The effect depends on whether the SHIFT and/or CTRL key is down while click the button. 

The options are:

Key down Result
NONE Displays the Fast Sort dialog box
SHIFT Displays Word’s Sort dialog box
CTRL Performs an ascending sort (A-Z) on the 

selection
CTRL+SHIFT Performs a descending sort (Z-A) on the 

selection



    Doc Browser™

 Options...

MegaWord Doc Browser lets you interactively browse through a document by any criterion, and gives you statistical 
information while you browse. Doc Browser is fully WYSIWYG (What You See Is Where You Go), which makes it a lot 
more intuitive than Word’s GoTo command. You’ll probably appreciate Doc Browser most if you want to find your way 
in a long document.

Running Doc Browser
To run Doc Browser, click 

. 
After a moment, a dialog box displays the active page of the document. Click the Options button at the top of this 
page for further steps.

While you browse, the preview is continuously updated, and the text above the preview tells you where you 
are in the document.

When you click Close the page you have last selected becomes the active page 
{button ,KL(`Doc Browser')} How do I work with Doc Browser?
{button ,JI(`>HowTo',`IDH_HOWTO_NOTES_BROWSER')} Special notes



    Browsing by page, section, or percentage
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{button ,JI(`>HowTo',`IDH_Doc Browser_CNT')} How to display the Doc Browser dialog box

To the right of the preview you see a Gauge. By default the gauge holds a list of all the pages in the document. 
To move quickly to a desired page, click the appropriate page number in the gauge. 
If a document holds more than one section, you can change the gauge to display section numbers. Click a 

number to jump to that section. 
The gauge also has the option to browse by percentage. Browsing this way is not entirely accurate, but will 

bring you more or less at the selected percentage level of the document.

While you browse by page, section or percentage, the “Statistics” box gives you statistical information about the page
that matches the criterion. 

The Start and End buttons below the preview let you quickly jump to the edges of the document.



    Browsing by criterion
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{button ,JI(`>HowTo',`IDH_Doc Browser_CNT')} How to display the Doc Browser dialog box

In the “Go To” list you can select the criterion by which you want to browse through the document. The default is 
Page, other options are: Section, Annotation, Footnote, Endnote, Field, Table, Graphic, Equation and Object. (Most of
these options are the same as the ones in Word’s "GoTo" dialog box.) 

Click Previous or Next to browse to the next or previous occurrence of the selected criterion. While you 
browse, the “Statistics” box provides relevant statistical information about the selected item. If the next item occurs on
a different page, the preview and page gauge are automatically updated.

If you’ve reached the first or last occurrence of a criterion, the “Statistics” box will tell you so.



    Browsing by bookmark
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{button ,JI(`>HowTo',`IDH_Doc Browser_CNT')} How to display the Doc Browser dialog box

If the document holds bookmarks, you can jump to any bookmark by checking the “Bookmarks” box. (If the document
doesn't contain bookmarks, this option is disabled.) The “Go To” list then shows all available bookmarks in the 
document. When you select a bookmark, the “Statistics” box displays up to 255 characters of the text associated with 
the bookmark. If the bookmark refers to a graphic, the “Statistics” box displays the graphic and provides information 
about it. 



    Synchronizing the document
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{button ,JI(`>HowTo',`IDH_Doc Browser_CNT')} How to display the Doc Browser dialog box

By default, Doc Browser “freezes” the document while you browse. This means that the document view is not 
updated until you close the dialog. 

To override this behavior, check the “Synchronize Document” box. With this box checked, the document 
behind the dialog box is continuously updated as you browse.



    Repaginating the document
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{button ,JI(`>HowTo',`IDH_Doc Browser_CNT')} How to display the Doc Browser dialog box

If the document hasn’t been saved before you run Doc Browser, MegaWord will force a repagination. If you notice 
that the pages don’t match reality, you can force Word to repaginate again, by clicking Repaginate.



    Special notes
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Doc Browser works only if a document holds text, and not in Macro view. 
Doc Browser always shows the document in Page layout view, even if the original view was different. When 

you close the dialog box, the original view is restored.
If the Preview doesn’t display a new page when you choose a button, this means that there are no more 

occurrences of the selected Go To item in the document.
If Doc Browser shows grayed out buttons, you cannot jump in that direction.



    Doc Hopper™

 Options...

MegaWord Doc Hopper gives you the fastest and most powerful navigation tool Word has ever known. Doc Hopper 
lets you quickly create an index of all text with a common style, and jump through the document in a fully interactive 
way. With Doc Hopper Lite you can even create distributable documents with built-in royalty-free Doc Hopper 
navigation technology.

Better than Bookmarks
Word’s own tools for jumping to specific locations in a document are limited to the GoTo and Bookmark dialog boxes. 
Both have serious shortcomings:

The GoTo dialog box doesn’t have an option to “go to” specific document text. 
Bookmarks allow you to jump to certain locations in a document, but it’s a method that requires a lot of 

preparation. And the Bookmarks dialog box doesn’t give an indication of each bookmark’s content until you have 
actually made the jump. 

{button ,KL(`Doc Hopper')} How do I work with Doc Hopper?

{button ,JI(`>HowTo',`IDH_HOWTO_LITEGENERAL_HOPPER')} How do I create distributable documents with Doc 
Hopper Lite? 

Note: Doc Hopper and Doc Hopper Lite don’t work with protected documents



    Running Doc Hopper
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1 To run Doc Hopper, click . If no index has been created for the active document, the dialog box shows only a list
of styles.

2 To build (or rebuild) an index of text that is formatted in a certain style, select the style from the list and click 
Build Index. 

Doc Hopper creates a list of all text that is formatted in the selected style. Depending on the size and contents of the 
document, this may take some time, but once the list is created it is kept in memory during the remainder of your 
Word session, even after you close the dialog box. The next time you run Doc Hopper, the list comes up in a split 
second.

Double-click on any line in the list to activate that part of the document. 
To jump through the document without closing the dialog box, hold down SHIFT and double-click in the list.

By default, the list shows the text in the order in which it is located in the document. Click “Alphabet” in the 
“Sort By” group to sort the text in alphabetical order. Your preference will become the default each time you use Doc 
Hopper.

Check the "Save index with document" box to store the last index you created as invisible "Inside 
Information" in the document. The next time you run Word and open the same document again, Doc Hopper will 
instantly display the previously created index. Uncheck box to remove the index from the document.



    Removing unused styles
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{button ,JI(`>HowTo',`IDH_HOWTO_RUN_HOPPER')} How to display the Doc Hopper dialog box
A document can contain many styles that are actually not in use. With Doc Hopper you can quickly remove these 
unused styles. This does not change any existing formats, but the consequence is that you can’t apply the removed 
styles to any current or future text in the document. Use this feature with care!

Click Clean Up to remove unused styles from a document

Note You may notice that Clean Up will still leave some styles in the list, even if they’re not in use. That’s a Word 
feature.



    Distribute documents with royalty-free Doc Hopper navigation technology. 
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{button ,JI(`>HowTo',`IDH_HOWTO_RUN_HOPPER')} How to display the Doc Hopper dialog box
Doc Hopper Lite is a reduced version of Doc Hopper that can be included with documents that you want to distribute, 
such as reports, documentation, etc. Once Doc Hopper Lite is included with a document, anyone who reads the 
document on-line can use the Doc Hopper navigation features, even if MegaWord 95 is not installed on their system.

Legalities
You have the royalty-free right to distribute documents with Doc Hopper Lite under the following conditions:

The creator or publisher of the document must be a registered MegaWord user.
The Doc Hopper Lite macro must be included unaltered.
The document in which Doc Hopper Lite is integrated must include the following text: 

"DOC HOPPER LITE IS INCLUDED AS PART OF THIS DOCUMENT TO FACILITATE JUMPING TO SPECIFIC TEXT LOCATIONS.
THIS FEATURE IS USED WITH PERMISSION FROM MERLOT INTERNATIONAL. THE FULL VERSION OF DOC HOPPER IS 
PART OF THE MEGAWORD 95 PACKAGE FOR WORD FOR WINDOWS 95."



    Adding Doc Hopper Lite to a distributable document

 Start of    topic      
 More options...

{button ,JI(`>HowTo',`IDH_HOWTO_RUN_HOPPER')} How to display the Doc Hopper dialog box
It's easy to prepare a document for use with Doc Hopper Lite. A dedicated macro, which is part of MegaWord 95 does
all the work for you. This is the procedure:
1 Open and activate the document in which you want to include Doc Hopper Lite.
2 Create an index for the active document. This can only be done with the full version of Doc Hopper. Make sure to 
check the "Save index with document" box.

3 Choose Tools / Macro. 
4 In the Macro dialog box, make sure that "All active templates" is selected, and select the Doc 
HopperLiteAddToDocument macro. Then click Run. This is what happens:

The active document is saved as a Word template
The Doc HopperLite macro is copied to the document. The copy is in read-only format.
A Doc Hopper Lite button is placed at the end of the Standard toolbar

5 Click the Doc Hopper Lite button. The dialog box should display the index you have created under step 2. If 
all jumps work correctly, your document is ready for distribution. After you have created a document that holds Doc 
Hopper Lite, you can at any time recreate the index as described under step 2. There's no need to go through steps 3
and 4 again.



    Doc Hopper notes
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{button ,JI(`>HowTo',`IDH_HOWTO_RUN_HOPPER')} How to display the Doc Hopper dialog box
It is not recommended to build an index based on common styles, such as “Normal” or “Default paragraph”. 

Doc Hopper is at its best if you use it to build a list of text in a Heading, Index, Caption, or TOC style.
You can use Doc Hopper with any open document. Doc Hopper keeps track of the documents in which you 

have worked and remembers the index created for each document. You can even close and reopen a document 
during your session; Doc Hopper will still remember the index you created for that document.

For reasons of memory efficiency, the list created by Doc Hopper never contains more than 250 entries, and
each entry contains only the first paragraph of the text formatted in the specified style, with a maximum of 100 
characters. 

Storing the index with the document increases the size of the document. In the “worst case” scenario, this 
increase will never be more than approx. 25KB. In common cases the size increase will be less than 3-5KB.



You can at any time recreate the index by clicking Build Index. You may want to create a new index for the currently 
selected style after you have made edits to the document. If you rename a document, or save it under a new name, 
you will also have to rebuild the index. Sometimes you may experience that Word loses track of the index entries; 
recreating the index will solve that problem.



Doc Hopper Lite is only available in the registered version of MegaWord 95.



    HotPad™

    Options...

MegaWord HotPad makes your numeric keypad hotter than ever. Without disabling cursor or input functions, HotPad 
makes every key on your keypad an instant shortcut key to your favorite Word commands or macros. HotPad is easy 
to disable, re-enable and re-configure.

Running HotPad the first time
1 If you haven’t run HotPad before, click  to display the HotPad dialog box. The statusbar at the bottom of the 
dialog box tells you whether HotPad is currently enabled or disabled. 

2 Click Enable. HotPad will assign its default commands to the keys on the numeric keypad. 
3 Close the dialog box and see how HotPad works.

Running HotPad commands
To run a command that is assigned to the keypad, make sure that the NumLock light is on. Then:
1 Press the slash key (/) on the numeric pad, 
2 Press any of the cursor/number keys, or the plus, minus or asterisk key. 
The associated command is immediately executed. 

Example    If you use the default HotPad key assignments, you can toggle Full Screen view on and off by pressing 
the slash key, and then the DEL key on your numeric keypad. 

{button ,KL(`Hotpad')} More about working with HotPad



    Default HotPad key assignments
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In the default configuration HotPad offers the following two-key shortcuts. (In this table, “/” refers to the slash key on 
the numeric keypad.)

Keys Command
/ , / HotPad Dialog Box
/ , * Show/Hide nonpr. Chars
/ , 0 Ins Arrange All Windows
/ , 1 End Format Font
/ , 2 Format Paragraph
/ , 3 PgDn Style
/ , 4 Find
/ , 5 Replace
/ , 6 Print
/ , 7 Home New Document
/ , 8 Open Document
/ , 9 PgUp Save Document
/ , - Undo Last Action
/ , + Redo Last Action
/ , . Del Toggle Full Screen

    Changing a HotPad assignment
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To assign a different built-in command or macro to a key, do the following:

1 Open the Hotpad dialog box (SLASH, SLASH)
2 Click Commands. HotPad takes a minute to build a list of available commands.
3 Click the key on the graphical display of the numeric keypad to which you want to assign a new command.
4 Select the desired command from the command list. A description of the selected command appears in the box 
below the list.

5 Click Assign 



    Verifying current assignments
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If you want to have a quick overview of your current HotPad assignments, do the following:

1 Open the Hotpad dialog box (SLASH, SLASH)
2 Click Show Current. This displays a list of all keys and the commands with which they are currently associated. 
3 Click Print to get a hardcopy of all current keyboard assignments.



    Resetting HotPad assignments
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Resetting a single HotPad assignment
If you have assigned a custom command to a key, you can at any time revert to the original HotPad assignment. To 
reset a single HotPad key, do the following:

1 Open the Hotpad dialog box (SLASH, SLASH)
2 Click the appropriate key on the graphical display of the numeric keypad
3 Click Reset. After your confirmation the original assignment is restored.

Resetting all HotPad assignments
You can at any time revert to all original HotPad assignments. The procedure:

1 Open the Hotpad dialog box (SLASH, SLASH)
2 Click Reset All. After your confirmation, all original assignments are restored.



    Disabling and enabling HotPad
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Temporarily disabling HotPad
In most cases there's no need to disable HotPad. You can use all numeric keys for calculations, except the division (/)
key on the numeric keypad. (The slash key on the main keyboard remains active, so you can use that one instead.) If
however, you want to temporarily disable HotPad, take the following steps:

1 Open the Hotpad dialog box (SLASH, SLASH)
2 Click Disable. Disabling HotPad does not affect your custom key assignments. 

To re-enable your HotPad assignments, click 
 and click Enable in the dialog box.

Automatically enabling HotPad at startup
Each time you start a new Word session, HotPad resumes its most recent status. If you haven’t disabled HotPad, all 
key assignments will automatically be re-activated when you start Word. 

If you have disabled HotPad as described above, check the "Auto-Enable at Startup" box to force HotPad to 
re-enable itself when you start Word

Permanently disabling HotPad
To disable HotPad completely, do the following:
1 Open the Hotpad dialog box (SLASH, SLASH)
2 Click Disable, and leave the Auto-Enable at Startup box unchecked. 
3 Close the dialog box. HotPad is immediately disabled and will not re-enable itself at startup.



    Hints for HotPad assignments
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When you assign new commands to the keys on the numeric keypad, the following hints may help you to use and 
memorize the assignments:

Assign your most used commands to the topmost number keys (7,8,9) and the asterisk key. These keys are 
easiest to press in combination with the slash key.

Try to assign a group of related commands to adjacent number keys. E.g. If you want to assign the EditCut, 
EditCopy and EditPaste commands to the keypad, consider the keys 4, 5 and 6.

Use the minus and plus key for more or less mnemonic commands, e.g. Shrink/Extend Selection, or 
Sub/Superscript 



HotPad does not work on keyboards without numeric keypad.



    View Manager

    Options...

MegaWord View Manager lets you set all your viewing options from a single dialog box, name and recreate views, 
and interactively display, dock and hide toolbars. 

Why View Manager?
Word’s built-in options to set your working environment are scattered over three menus and four dialog boxes. With 
View Manager everything becomes a simple point-and-click operation in a single dialog box. And that’s only the start. 
Once you have created your viewing environment, View Manager lets you save that view under a meaningful name 
and recreate it later with a simple mouse click. You can even completely customize each of Word’s four main views, 
and let them display your documents in a way that matches your ideas. All options in the View Manager dialog box 
are interactive; each setting becomes instantly active while the dialog box is displayed, allowing you to correct or fine-
tune your settings.

{button ,KL(`View Manager')} How do I work with View Manager?



    Running View Manager
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To display the View Manager dialog box, do one of the following:
Click 

Press F10
Choose View Manager from the View menu

In the View Manager dialog box you have access to all Word’s view options, spread over four tabs. 

View Tab. Activate and manage any named or built-in view. Split the current document into two panes, activate the 
top or bottom pane, or close the pane you have finished working with. 

Workspace Tab. Display and hide each available toolbar, and specify where you want to “dock” it. Display and hide 
Word’s menu bar and any other bar that surrounds your workspace. 

Zoom / Effects Tab. Set your zoom options fully interactively. Quickly toggle between displaying your text in black on 
white, or white on blue, or activate the "Draft Text" and "Wrap to Window" modes

Document Tab. Hide and display document components just as in Word’s Tools Options View dialog box. Changes 
take place while you click!



    Activating a saved view
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{button ,JI(`>HowTo',`IDH_RUN_VIEWMAN')} How to display the View Manager dialog box
On the Views tab, double-click on a View in the Saved Views list to apply all associated settings to the 

current document. 

The View Manager dialog box always highlights the last View you selected. Double-click that name to apply the same
view again.

Check “Include Toolbars with Views” to display only the toolbars that were active when you saved the view, 
hiding the ones that weren’t. This setting remains active in your next Word sessions until you change it.



    Creating and saving a view
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{button ,JI(`>HowTo',`IDH_RUN_VIEWMAN')} How to display the View Manager dialog box
After you have created the right viewing environment for a specific task or document, you can save those settings for 
later use, and recreate the view without going through all the details again. 

Saving a View takes the following steps:
1 Create your viewing environment from the options on the four tabs of the View Manager dialog box
2 On the Views tab, click Save As... 
3 Type a meaningful name
4 Click OK.

All workspace, zoom and document settings are saved with the View name and will reappear in exactly the same way
when you choose that View again. 

Including Toolbars with Views
When View Manager saves a view, it also stores the names of the toolbars that are currently displayed. By default 
however, View Manager does not take those toolbar settings into account when it recreates a view. 

You can override that behavior by checking the “Include Toolbars with Views” box on the Views tab. When 
you activate a view with this box checked, all toolbars are hidden, except the ones that were displayed when you 
saved the view. This setting remains active in your next Word sessions until you change it.



    Modifying, renaming, deleting views
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{button ,JI(`>HowTo',`IDH_RUN_VIEWMAN')} How to display the View Manager dialog box

Modifying a view
To make changes to the settings of a named view, proceed as follows:
1 On the Views tab, double-click the view you want to modify. 
2 Make your adjustments on any of the four tabs. 
3 Click Save As... 
4 To save the modified view under its original name, confirm the existing name when prompted. To save the view 
under a different name, type a new name and confirm.

Renaming and deleting views
To change the name of a view, click Rename, type a new name when prompted, and confirm your decision. 
To delete a View name from the list, click Delete and confirm when prompted.



    Customizing Word’s main views
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{button ,JI(`>HowTo',`IDH_RUN_VIEWMAN')} How to display the View Manager dialog box

Background info
Normally, when you select a view from Word’s View menu, only the appearance of the document changes. Toolbars, 
scrollbars, rulers and the statusbar are usually untouched. Settings that affect what is displayed in a document, and 
how it is displayed, also remain unchanged. 

With View Manager you can change all that. Now you can decide, for example, that in Page view you want to see two
pages, no horizontal scrollbar and no Formatting toolbar; in Normal view you want a 120% zoom factor and all 
nonprinting characters visible, in Outline view you want white on blue text, and in Master Document view you want to 
zoom down to 80% and make highlights invisible.

{button ,JI(`>HowTo',`IDH_WORKWITH_VIEWMAN')} Click here for more about customizing Word’s main views



    Working with customized main views
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{button ,JI(`>HowTo',`IDH_RUN_VIEWMAN')} How to display the View Manager dialog box

Customizing a Main View
You can modify the settings of each of Word’s main views. Follow these steps:
1 Activate the Views tab
2 In the “View” list, select the view you want to modify: Normal, Outline, Page Layout, or Master Document. 
3 Fine-tune the settings of that view with the options on the four tabs. 
4 Click Set Default View, and confirm when prompted. 

Activating a customized Main View
Once you have customized a main view, View Manager automatically recreates all associated settings when you 
select that view from the View menu. 

If the “Include Toolbars with Views” box on the Views tab is checked, all toolbars associated with that view 
are also displayed, and all “alien” toolbars are hidden.

Bypassing a customized Main View
To temporarily activate Word’s own settings for a view, hold down SHIFT when you select that view from the View 
menu. 

Resetting a Main View
To permanently cancel your customized settings for a main view, select the appropriate view from the “View” list and 
click Reset. After your confirmation, your settings will be deleted, and Word will default to its own settings.



    Working with panes
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{button ,JI(`>HowTo',`IDH_RUN_VIEWMAN')} How to display the View Manager dialog box
You can split a document, and view each pane in different ways. Follows these steps:
1 Activate the Views tab
2 Click Split to split the document in two equally sized panes. 
3 In the “Panes” group, selecting the appropriate option button to activate the top or bottom pane. 
4 Apply any of the settings on the four tabs to only that pane (the exceptions are toolbars and the “White on Blue 
Text” options which are global settings). 

5 To close a pane, activate the pane you want to keep open, and click the button with the appropriate text.



    Working with toolbars
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{button ,JI(`>HowTo',`IDH_RUN_VIEWMAN')} How to display the View Manager dialog box
View Manager makes it easier to display and hide toolbars than Word’s View Toolbars dialog box, with the added 
feature that you can also move toolbars around your workspace. 

Displaying, docking and hiding toolbars
Activate the Workspace tab. The "Toolbars" list shows all toolbars in alphabetical order, with all visible 

toolbars at the top of the list (visible toolbars have a dash in front of their name).
To display a toolbar that’s currently not visible, select the name in the list and click Display. 
To hide a toolbar, select its name from the list (a dash indicates a visible toolbar) and click Hide. 

When you select a toolbar in the list you can also define where the toolbar is displayed. The options are available in 
the “Position” group. 

To display a toolbar at its most recent position, select “Default”. 
To display or move a toolbar to one of the four sides of your workspace, select the appropriate option. Then 

click Display or Dock.



    Quick Options
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Repeating the last view
To repeat the last view you activated without displaying the View Manager dialog box:

Hold down CTRL, and click 

Toggling between Black on White and White on Blue text
To quickly change between the two ways of displaying your document:

Hold down SHIFT, and click 



    Special notes
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Macro Views
When you save a View while a macro window is active, View Manager stores the settings as a view that can only be 
applied to macro windows. When you attempt to activate a macro view to a normal document, a message box will tell 
you that you can’t apply that view. Likewise, if a macro is active, you can’t apply a view that is associated with a 
regular document.

"White text on blue" option
You could consider the “White Text on Blue” option as your preferred setting for working in documents that don’t have 
a lot of pictures or colors, such as a macro document. You may find it easier on the eye, and it is a potential battery-
saver on your portable! 

View names
When you give a name to a View, make sure that the name is less than 50 characters long, and does not contain the 
characters = [ ] or a comma or semi-colon. There is no limit to the number of views you can save, but a very long list
(say more than 20 views) will obviously have a negative effect on the speed at which the dialog box is displayed. 



Window Manager

 Options...

MegaWord Window Manager lets you manipulate document windows like never before. You can arrange windows in 
four ways, close multiple documents with a single button click, permanently delete documents and macros, and 
instantly create multiple instances of the same document window

Running Window Manager
To run Window Manager, do one of the following:

Click 

Choose Window Manager from the Window menu

The dialog box lists all your currently open documents. To arrange, close or delete a subset of these windows, you 
must move them to the “Selected Windows” list.

To move a single window name from one list to the other, double-click it. 
To move all window names from one list to the other, hold down SHIFT, and double-click any window name. 

Select All Windows by Default
Check "Select All Windows by Default" to let the dialog box always come up with all windows listed in the 

“Selected Windows” list. The setting remains in effect during your next Word sessions until you change it.

{button ,KL(`Window Manager')} How do I work with Window Manager?



    Arranging selected windows
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{button ,JI(`>HowTo',`IDH_WinMan_CNT')} How to display the Window Manager dialog box

To arrange the selected windows over your workspace, do the following:
1 Select the Arrange tab
2 Select one of the four Arrangement options. 
3 Click OK. 

After the windows have been arranged, the dialog box stays open so that you can change your settings. In some 
cases you may see that the arranged windows either don’t fit in the workspace, or are displayed smaller or larger 
than necessary. If that’s the case, click OK again to rearrange the windows.

Tip To arrange windows and close the dialog box immediately, hold down SHIFT when you click OK.

{button ,JI(`>HowTo',`IDH_WRAP_WINMAN')} Rearranging the text to fit the window size
{button ,JI(`>HowTo',`IDH_SHORTCUT_WINMAN')} Arrangement shortcuts



    Arrange & Wrap 
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{button ,JI(`>HowTo',`IDH_WinMan_CNT')} How to display the Window Manager dialog box

Usually when windows are arranged, part of the document contents falls “off the screen”. To keep the entire text width
visible, choose the wrapping option in the "Apply to all Arranged Windows" group. Wrapping means that Word 
rearranges the text to fit the window size. Since wrapping is not available in Page Layout view, you must first select 
the "Normal View, Wrap Text" box. You can then select a zoom factor of 100% or 75%. After you have made your 
wrapping choices, all arranged document windows will display the full document text.

Wrapping without Arranging 
You can also first arrange the windows you want to see and apply wrapping without changing the zoom factor. 

On the Arrange tab, click Wrap to apply wrapping to all currently visible documents. 
If the button has the label Unwrap this means that the active document is already wrapped; clicking the 

button will then undo text wrapping. 



    Arranging all windows

 Start of    topic        
 More options...

{button ,JI(`>HowTo',`IDH_WinMan_CNT')} How to display the Window Manager dialog box

Window Manager offers three quick ways to manipulate all open document windows at the same time. 
Click Minimize All to minimize all windows and place them at the bottom of the Word screen.
Click Arrange All to give all windows an equal share of the workspace. (This option behaves differently than 

the Arrange All option on Word's Window menu, which arranges only the windows that are not minimized.) 
Click Maximize All to display all windows at their maximum size.

{button ,JI(`>HowTo',`IDH_WRAP_WINMAN')} How to rearrange the text to fit the window size



    Closing document windows
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{button ,JI(`>HowTo',`IDH_WinMan_CNT')} How to display the Window Manager dialog box

To close the shortlisted windows, select the Close tab. Your options are the following:

Confirm Each: you are prompted to save each modified document 
Save Always: each document is automatically saved 
Don’t Save: each document is closed without saving.

Click OK to confirm your choice.



    Deleting documents and macros
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{button ,JI(`>HowTo',`IDH_WinMan_CNT')} How to display the Window Manager dialog box

Select the Delete tab to permanently delete the selected files and macros from your system. This is a dangerous 
command, but this option is handy if you want to get rid of temporary documents and scrap macros. There are two 
ways to delete documents. 

Wipe out. Unsaved documents are closed without saving, other documents are closed and deleted from 
your disk, macros are removed from their template. 

Move to... Before wiping out the file, Window Manager creates a backup in your default temporary folder, 
allowing you to retrieve the document if you made a mistake. If this folder doesn't exist, the "Move to..." option is 
unavailable, and no backup is created. 

Before Window Manager deletes files you are asked to confirm the action. You can bypass the confirmation 
by unchecking the "Confirm each" box.



    Creating multiple views of a document 
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{button ,JI(`>HowTo',`IDH_WinMan_CNT')} How to display the Window Manager dialog box

Select the MultiView tab to display multiple views ("panes") of a selected document. Once you have created two, 
three or four panes, you can choose different views and zoom factors for each pane and work in each copy of the 
document. You can browse independently through each pane, make modifications and cut, copy and paste across 
panes. 

The following explains the options in the "Duplication Style" group:
Side by Side. A second copy of the document is created. The two copies of the document are arranged 

from left to right. 
Top to Bottom. The document is split into two equal halves.
3 Panes. A second copy of the document is created. The two copies of the document are arranged from left 

to right. The rightmost document is split into two equal halves.
4 Panes. A second copy of the document is created. The two copies of the document are arranged from left 

to right. Both documents are split into two equal halves.

Pane Zoom Options
You can choose from seven preset views for each pane. Each pane can have a different setting. The options for each
pane are:

100%. The document is displayed in Normal view, and 100% magnification. 
100% (Wrap). The document is displayed in Normal view, and 100% magnification. The text is wrapped to fit

the window.
75%. The document is displayed in Normal view, and 75% magnification. 
75% (Wrap). The document is displayed in Normal view, and 75% magnification. The text is wrapped to fit 

the window.
Page Width. The document is displayed in the current view, and zoomed to fit the available window width.
Whole Page. The document is displayed in the Page layout view, and zoomed to be displayed from top to 

bottom.
Thumbnails. The document is displayed in a number of small-size full pages



    Window Manager shortcuts
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You can quickly arrange all open document windows without displaying the dialog box, by holding down the SHIFT 
and/or CTRL key while you click . This is the effect:

Key down Window arrangement
SHIFT Cascade 
CTRL Top to Bottom 
SHIFT+CTRL Left to Right 



    Zoom Manager

 Options...

MegaWord Zoom Manager gives you ultimate control over Word’s zoom features, plus two configurable hotkeys for 
instant zooming in and out. Now you can set your document view, full screen view and zoom factor interactively from 
a single dialog box. From the toolbar you have even more zoom options.

Running Zoom Manager
MegaWord Zoom Manager is designed to replace and enhance Word’s Zoom command.

To display the MegaWord Zoom Manager dialog box, do one of the following:
Select Zoom from the View menu
Hold down CTRL and click 

 or 

To display Word’s built-in Zoom dialog box:
Hold down SHIFT and select Zoom from the View menu

{button ,KL(`Zoom Manager')} How do I work with Zoom Manager?



    Setting the zoom options

 Start of    topic      
 More options...

{button ,JI(`>HowTo',`IDH_ZoomMan_CNT')} Displaying the Zoom Manager dialog box
The “Zoom To” group holds the same options as Word’s own Zoom dialog box. The difference is that you don’t have 
to close the dialog box to see the result of your settings. Choosing an option in the Zoom Manager dialog box 
immediately activates the setting, allowing you to make corrections, or fine-tune your settings. Options that are 
grayed out are not available in the current view. 

Click 
 and 
 to interactively fine-tune the zoom factor in increments and decrements of one percent.

The “Wrap Text to Window” option is available in all views, except Page Layout view and Print Preview. If 
you check this box, the document text will be displayed over the full width of the document window, regardless of the 
zoom factor you have chosen. In other words: you can always read the full text.

{button ,JI(`>HowTo',`IDH_OKCANCEL_ZOOM')} What happens when you click OK or Cancel
{button ,JI(`>HowTo',`IDH_WRAP_ZOOM')} More about wrapping



    Selecting the view
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{button ,JI(`>HowTo',`IDH_ZoomMan_CNT')} Displaying the Zoom Manager dialog box
The “View” group offers you two options you don’t find in Word’s Zoom dialog box. 

From the listbox you can instantly change the way your document is displayed. The options are the same as
on the View menu, plus Print Preview. When you activate a view, the options in the “Zoom To” group are 
automatically adjusted. 

Check “Full Screen” to switch Word into Full Screen view. Uncheck the box to redisplay all hidden screen 
elements.

The advantage of selecting a view from the Zoom Manager dialog box is that you can now activate zoom options that 
would otherwise not be available. For example, if you usually work in Normal view, Word’s Zoom dialog box doesn’t 
let you zoom down to display two pages. In the MegaWord Zoom Manager dialog box you can select Page Layout 
from the View list, then select the “Two Pages” option in the “Zoom To” group, to display your document in two-page 
view.

{button ,JI(`>HowTo',`IDH_OKCANCEL_ZOOM')} What happens when you click OK or Cancel



    QuickZoom settings 
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{button ,JI(`>HowTo',`IDH_ZoomMan_CNT')} Displaying the Zoom Manager dialog box
The options in the “QuickZoom Settings” group let you set your preferences for the  and 
 buttons, and the associated keyboard shortcuts. 

In the “Custom Zoom Increments and Decrements” box, specify which percentage MegaWord adds to or 
subtracts from the current zoom factor when you use these shortcuts. The range must be from 5% to 50%. Click 
 and 
 to adjust the value in 5% increments.

Check or uncheck The “Wrap Text...” box. When it is checked, MegaWord will display the document text 
over the full width of the document window when you zoom in and out, regardless of the zoom factor. This feature 
works in all views except Page Layout view. If you leave the box unchecked, MegaWord will not wrap the text to fit 
the window. 

{button ,JI(`>HowTo',`IDH_OKCANCEL_ZOOM')} What happens when you click OK or Cancel
{button ,JI(`>HowTo',`IDH_WRAP_ZOOM')} More about wrapping



    What happens when you choose OK or Cancel
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{button ,JI(`>HowTo',`IDH_ZoomMan_CNT')} Displaying the Zoom Manager dialog box
When you click OK in the Zoom Manager dialog box, MegaWord leaves all your zoom, wrap and view 

settings active, and save the options you have selected in the “QuickZoom Settings” group. 
When you click Cancel, MegaWord cancels all your zoom, wrap and view settings, and returns your 

document to its original state. Any settings you have chosen in the “QuickZoom Settings” group will be ignored.

Hint    You can use this behavior of the Cancel button to have a quick look at your document in a different view and/or
zoom factor, and then return to your original view. Just display the dialog box, make your view and zoom choices, 
move the dialog box to the edge of the screen, look at the document, and then choose the Cancel button.



    Quick Zoom via the toolbar
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By clicking the  and 
 buttons you can quickly adjust the zoom factor. The percentage that is added to or subtracted from the current 

zoom factor can be specified in the Zoom Manager dialog box. The default value is 20%. Wrapping is applied if the 
appropriate box in the Zoom Manager dialog box is checked. Both buttons allow the use of the SHIFT and CTRL key 
for additional zoom options. Here is an overview:
Zoom Up: hold down one of the following keys and click 

Key down Result
none Adds to current zoom 
SHIFT Zooms to Page Width scale
CTRL Displays the Zoom Manager 
SHIFT+CTRL Resets to 100%, cancels Wrapping

Zoom Down: hold down one of the following keys and click 
Key down Result
none Subtracts from current zoom 
SHIFT Zooms to Full Page scale
CTRL Displays the Zoom Manager 
SHIFT+CTRL Resets to 100%, cancels Wrapping

{button ,JI(`>HowTo',`IDH_WRAP_ZOOM')} More about wrapping



 Quick Zoom via the keyboard
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{button ,JI(`>HowTo',`IDH_ZoomMan_CNT')} Displaying the Zoom Manager dialog box
You can quickly adjust the zoom factor with two convenient keyboard accelerators. (This option is only available on 
keyboards with a numeric keypad.) The percentage that is added to or subtracted from the current zoom factor can 
be specified in the Zoom Manager dialog box. The default value is 20%. The hotkeys are:

ALT+PLUS (on the numeric keypad): adds the specified percentage to the current zoom factor
ALT+MINUS (on the numeric keypad): subtracts the specified percentage from the current zoom factor



 More about wrapping
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{button ,JI(`>HowTo',`IDH_ZoomMan_CNT')} Displaying the Zoom Manager dialog box
When you select one of the “Wrapping” options in the Zoom Manager dialog box, Word does not change the 
formatting of the document when wrapping is applied. Only the document contents are rearranged to fill the available 
workspace width, allowing you to read the text without having to use a horizontal scrollbar. When Word wraps the 
text, column formatting is ignored. If the document holds tables that exceed the boundaries of the workspace, they 
may not entirely be visible without scrolling. As far as we can tell, Word does not save the wrapping status when you 
close the document. When you save a wrapped document, and later re-open it, it will be unwrapped.



    SmartSplit™
MegaWord Smart Split is an enhanced version of Word’s built-in document splitting feature. Smart Split gives you a 
fast keyboard interface, and knows which pane to close if you run the command in a split document. SmartSplit can 
also mimic a vertical split, and create four panes of the same document. After you have split the document, you can 
browse through each pane, make edits, and even apply different views to each pane.

Creating a vertical split
To create a split from top to bottom, do one of the following:

Hold down ALT and press the slash key (/). 
Click 

Choose Split from the Window menu,

Creating a horizontal split
When Smart Split creates a horizontal split, it actually creates a second copy of the current document, and places the
two copies side by side. To create a horizontal split, do one of the following:

Hold down CTRL and click 

Hold down CTRL and choose Split from the Window menu,

Creating a vertical and horizontal split
When Smart Split creates a vertical and horizontal split, it creates a second copy of the current document, places the 
two copies side by side, and applies a vertical split to each copy. The steps:

Hold down CTRL+SHIFT and click 

Hold down CTRL+SHIFT and choose Split from the Window menu,

Removing a vertical split
If the window is already split, place the insertion point in the window pane that you do not want to close and do one of
the following:

Hold down ALT and press the slash key (/). 
Click 

Choose Remove Split from the Window menu

Removing a horizontal split
To remove a horizontal split, close one of the two copies of the document, and maximize the remaining copy.

Notes: 
When Smart Split creates a horizontal split, it calls a function in the MegaWord WindowManager macro, 

which must be installed.
Smart Split can not create a horizontal split if the current document is a macro document.



    Button Picker
MegaWord Button Picker gives you the easiest way to modify or add new buttons to your toolbars. It's a little known 
fact that Word comes with no less than 366 built-in toolbar buttons. Unfortunately, Word doesn't give you an interface 
to use them. That's why MegaWord gives you the Button Picker. The two-click method that lets you copy any built-in 
button picture to any toolbar.

Copying toolbar buttons
If you want to replace an existing button on a toolbar with one of the 366 built-in buttons, make sure that both the 
toolbar you want to change and the All Buttons toolbar are displayed. Here are the steps to follow:
1 To display the All Buttons toolbar, choose Toolbars from the View menu, check the box in front of the All Buttons 
entry, then click OK. 

2 Click with the right mouse button on any toolbar button and choose Customize. 
3 Move the Customize dialog box as far out of your workspace as possible, to create enough room to make both 
toolbars visible. 

4 In the All Buttons toolbar, click with the right mouse button on the toolbar button you want to copy.
5 Choose Copy Button Image.
6 Move the mouse pointer to the button in the toolbar you want to change and click with the right mouse button.
7 Choose Paste Button Image.
8 Repeat steps 4 through 7 for each button you want to change
9 Move the Customize dialog box back into your workspace and click Close.

Editing toolbar buttons
If you want to modify the toolbar button you’ve just copied, change the steps described above as follows:
8 Click with the right mouse button on the toolbar button you’ve just copied
9 Choose Edit Button Image. This displays Word’s Button Editor.
10 Make the changes to the button image, then click OK 
11 Repeat steps 4 through 10 for each button you want to change
12 Move the Customize dialog box back into your workspace and click Close.



    FastSwitch™
MegaWord Fast Switch is a simple utility, designed to make you work easier when you're working in Full Screen 
mode. In this mode, you don't see a titlebar, so you may not always be certain which document you're working on. 
And switching from one document to another can be awkward, because the menu bar is invisible, too. That's where 
Fast Switch comes in handy. It displays a list of all currently open documents, and with the name of the current 
document highlighted. You can switch to any document on the list, or just close the dialog box if you only wanted to 
know the name of the active document.

Running Fast Switch
When you work in Full Screen mode, click 

 on the Full Screen toolbar to display the dialog box.



    FastProof™

 Options...

Word comes with a nifty background speller and a spellcheck popup menu. But this feature has a serious limit: it 
never offers more than five spelling suggestions, and there’s no option to add a correctly spelled word to a dictionary. 
That’s why FastProof is designed to do a better job. When a word is misspelled, FastProof shows you all corrections, 
plus synonyms for each suggested word, plus the option to globally correct a misspelling or replace a word with a 
synonym and correctly apply all word forms. And if the word is correct in your eyes, you can instantly "legalize" it by 
adding it to a dictionary.

Running FastProof
FastProof is one of the options on Word's popup spellcheck menu, but is also available on most other right-click 
shortcut menus. To run FastProof, place the insertion point in or after the word of which you want to check the 
spelling and do one of the following:

Click 

Click the right mouse button and select FastProof from the menu.

If the current selection spans more than one word, FastProof selects the first word in the selection before the dialog 
box is displayed. The original selection is automatically restored when you return to the document.

Running FastProof in a Macro Window
Unlike Word’s own spell checker, FastProof also lets you check the spelling of words in a macro window. 

{button ,KL(`FastProof')} How do I work with FastProof?



    Correcting misspellings
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{button ,JI(`>HowTo',`IDH_FastProof_CNT')} How to display the FastProof dialog box
The FastProof dialog box displays two lists. If the selected word is misspelled, the first list shows suggestions for 
corrections. If the spelling is correct, or if the word doesn’t exist in the dictionary, the list shows the text [no 
suggestions]. The second list displays alternative words (synonyms, antonyms or related words) for each word in the 
first list. If no alternative words are available, the list shows the text [no suggestions].

You can click on any word in either list to copy it to the "Change to" box. Then click Change to replace the 
original word with the correctly spelled word or the selected synonym. 

If the word you typed is one of your common spelling errors, click AutoCorrect to replace the word and add 
an entry to your current AutoCorrect list, so that the next time you make the same spelling mistake, the correct word 
is automatically inserted instead.



    Adding correctly spelled words to a dictionary
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{button ,JI(`>HowTo',`IDH_FastProof_CNT')} How to display the FastProof dialog box
If a word is flagged as a misspelling, but is actually correctly spelled, you can add it to one of your custom 
dictionaries. Select the dictionary at the right of the "Add words to" button, and click that button to add the currently 
selected word to the dictionary. The next time you type the same word, it won’t be flagged as a misspelling.



    Globally replacing a word with a synonym
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{button ,JI(`>HowTo',`IDH_FastProof_CNT')} How to display the FastProof dialog box
When you select a correction or synonym to replace the original word, you can check the “Change All” box 

to apply the change to the entire document. 
When the “Change All” box is checked you have the additional option to check the “Change all word forms” 

box. 

If, for example, the original word is “build”, and you want to replace it with “construct”, checking both boxes will also 
replace “built” with “constructed”. 

If you use the “Change all” option, it’s recommended to also check the “Highlight changes” box. 

This allows you to browse through the document and check to see if the global replacement didn’t change words that 
shouldn’t have been replaced. In the case of our example, each occurrence of “building” would have been replaced 
with “constructing”, which may not always be what you want. 

To find all highlighted corrections, open the Edit/Find dialog box, clear the "Find what" box, and select 
"Highlight" from the Format button.



    Browsing trough all misspellings
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{button ,JI(`>HowTo',`IDH_FastProof_CNT')} How to display the FastProof dialog box
If the document holds spelling errors beyond the currently selected word, click "Next error" to jump to the next 
misspelling. After the end of the document is reached, the search for misspellings will continue from the start of the 
document.

Hold down SHIFT+CTRL and click 
 to find the first misspelling in the document and display the FastProof dialog box



    Using wildcards
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{button ,JI(`>HowTo',`IDH_FastProof_CNT')} How to display the FastProof dialog box
Are you looking for a word, but you don’t know how to spell it? Or are you interested in finding words that share the 
same characters? Then just type part of a word and use the asterisk or question mark as a wildcard character, and let
FastProof come up with a list of matching words. The rules for using wildcards are the following: use ? as a wildcard 
for a single character, and * as a wildcard for a range of one or more characters. Here are two examples. 

Example 1    You want to know which words start with the characters protec. Type protec* (one asterisk to indicate 
that you accept any number of characters) and FastProof comes with a list that holds words like: protect, protected, 
protecting, protection, protectionism, protective, etc.

Example 2    Suppose you don’t know if the correct spelling of a word is bycycle or bicycle. Type b?cycle (one 
question mark to indicate that you’re looking for a single character) and FastProof shows the correct spelling: bicycle.



    Shortcuts to proofing tools
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By holding down the SHIFT and/or CTRL key while you click  or while you select FastProof from a shortcut menu, 
you can immediately run Word’s main proofing tools or jump to the first misspelling in a document. Here is an 
overview:

Key down Result
SHIFT Run Word’s Spell Checker
CTRL Run Word’s Synonym program
SHIFT+CTRL Find the first misspelling in the 

document and display the 
FastProof dialog box



    Word Count

 Options...

MegaWord Word Count enhances Word’s own word counter. The MegaWord version lets you count the words in any 
specified part of your document, optionally with a readability statistics report about that part. 

Running Word Count
To display the MegaWord Word Count dialog box, do one of the following:

Click 
.

Select Word Count from the Tools menu

To display Word’s built-in Word Count dialog box:
Hold down SHIFT and click 

.
Hold down SHIFT and select Word Count from the Tools menu

Shortcut
To get a quick word count for the text between the start of the document and the current insertion point:

Hold down CTRL and click 
.

This is a handy feature if you write articles that must have a limited number of words or characters.

{button ,KL(`Word Count')} How do I work with Word Count?

{button ,JI(`>HowTo',`IDH_HOWTO_TITLEBAR_CURDOC')} Click here to find out how to display a quick 
wordcount on the titlebar of the active document. 



    Specifying the range for the wordcount
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{button ,JI(`>HowTo',`IDH_WordCount_CNT')} Displaying the Word Count dialog box

Word Count makes an assumption of what part of the document you want to get statistics. 
If the insertion point is inside a table, the initial word count refers to the table contents. 
If exactly one line, paragraph, page or section is selected, statistics are reported for that part of the 

document. 
If there is another type of selection, you get the wordcount in that selection. 
In all other cases the words in the entire document are counted. 

If you want to retrieve statistics for another part of the document, select the desired range from the 
“Statistics for:” list. Only the currently available options are listed. Wordcount ranges include: Document, Page, 
Section, Paragraph, Sentence, Line, Table, Selection, Frame, Text Above and Text Below. The word count starts 
immediately after you have selected a range. 

If the document holds footnotes and endnotes you can check the “Include Footnotes and Endnotes” box to 
include them in the count. 



    Attaching statistics to the document
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{button ,JI(`>HowTo',`IDH_WordCount_CNT')} Displaying the Word Count dialog box

If you have selected “Document” as the range, you can easily attach the statistical information as an endnote to your 
document. 

To do this, click Attach... 

If you have also requested readability statistics, these will be included together with the wordcounts in the endnote. If 
you don’t want to include the readability statistics, uncheck the “Report Readability Statistics” box before you click 
Attach...  A message box will ask your confirmation. Choose Yes to add the endnote, choose No to cancel this option. 



    Readability statistics
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{button ,JI(`>HowTo',`IDH_WordCount_CNT')} Displaying the Word Count dialog box

If you want a full report on the readability of the selected document range, including a sentence count, check
the “Report Readability Statistics” box. 

The dialog box expands to display statistical information about the grammar style in the range. Most of the additional 
statistics are self-explanatory. Here’s a short description of the last four statistics:

Flesch Reading Ease    An analysis of the average number of syllables per word and the average number of words 
per sentence. The range goes from 0 to 100%. A high score indicates that a high number of readers can understand 
the document with ease. Most people write documents that score between 60 and 70%.

Flesch-Kincaid Grade Level    This formula translates the Flesch Reading Ease score into a grade-school level. A 
score of 8.0 means that an eight-grade pupil would understand the text. Most people write documents at a seventh to 
eight grade level..

Coleman-Liau Grade Level, Bormuth Grade Level    Both formulas also analyze the text and represent the score as
a grade-school level. In this case the formula is based on the word length in characters and sentence length in words.

Note    Readability statistics are not available if the Grammar option for the language of the document is not installed, 
or if the document holds text formatted in mixed languages. 



    Date Manager

 Options...

MegaWord Date Manager is designed to enhance Word’s Date and Time command. The MegaWord version offers 
more date types and formats, and lets you insert any date/time in any language supported by Windows. Date 
Manager also lets you insert calendars in your document, in any language, size and format. Finally, with Date 
Manager you can make date and Biorhythm calculations. 

Running Date and Time
To display the MegaWord Date Manager dialog box, do one of the following:

Click 
.

Select Date and Time on the Insert menu

To display Word’s Date and Time dialog box:
Hold down SHIFT and click 

., or
Hold down SHIFT and select Date and Time on the Insert menu

Shortcuts
Hold down these keys and click  for the following effects:

Key down Result
CTRL Insert the current date 
SHIFT+CTRL Display your “advice of the day”

{button ,KL(`Date Manager')} How do I work with Date Manager?



    Inserting the date and time
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{button ,JI(`>HowTo',`IDH_DateMan_CNT')} How to display the Date Manager dialog box

You can insert any date from the Date/Time tab. Initially the dialog box displays the current date. To insert the date in 
the document, select one of the "Insert formatted date as" options:

Plain Text. The date is inserted as text.
Copy to Clipboard. The date is copied to the Windows Clipboard . After you have closed the dialog box, 

you can press CTRL+V to insert the date at the insertion point.

Language/Country Options. By default, Date Manager operates in the language for which Windows is set up. The 
list shows dozens of other language/country combinations. When you select a combination, the dates are 
automatically translated in the appropriate language and formatted for the selected country. Unlike Word itself, 
MegaWord extracts all date, language and country information directly from Windows. This explains why Date 
Manager can format dates in languages that are not supported by Word, such as Afrikaans, Icelandic and Bahasa. 
(This is also the reason why you can’t insert dates as fields. If you want to insert a date field, use Word’s own dialog 
box, or press ALT+SHIFT+D.)

Bypassing and resetting the system default. After you have selected a language/country that differs from the 
system default, Date Manager will use your choice as the future default. This is handy if, for example, Windows is set 
up for USA defaults, but you’re running a French or German version of Word. To revert back to the system default 
country and language, click Reset.

Adding or removing languages. If you run Windows Setup to add or remove Multilanguage support, you can 
quickly update the country/language list in Date Manager, by holding down CTRL while you click Reset. 
MultiLanguage support includes Eastern European languages, Greek and Russian. Provided the correct dialog font is
installed, Date Manager can display dates and calendars in all these languages.

Selecting the Format of the Date
You can insert the date in one of over 25 preset formats. The "Formats" list holds common formats for the USA and 
most European countries. Unlike in Word’s own Date and Time dialog box, the first two dates are always the default 
short and long date format used in the selected country. If you also want to insert the current time after the date, 
check the Include Time box. After you have inserted the date, the selected format will be the default the next time you
run Date Manager

Click OK to insert the date and close the dialog box.



    Selecting a date other than the current date
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{button ,JI(`>HowTo',`IDH_DateMan_CNT')} How to display the Date Manager dialog box

Date Manager makes it easy to insert a date that differs from the current date. You can use this feature to backdate a 
letter, or to insert a date in a report that is due out some time in the future. You can also make date calculations, 
which can be handy if you want to insert a “final payment” date in an invoice, e.g. a date 60 days from today. 

Select a day/month/year combination in the “Selected date” group. The formatted dates are immediately 
updated. To revert back to the current date, click Today.

Specfy values in the “Earlier or later date” group. Use negative values to find a date in the past. For 
instance, to find the date 3 days before the date 5 years and 2 months after today, specify -3 for days, 2 for months, 5
for years. The calculated date is based on the date you have selected in the “Selected date” list (which doesn’t have 
to be the current date). Click Calculate to see the resulting date in the “Formats” list, which you can then insert in the 
document, or copy to the Clipboard. The date range covers all years from 1601 to 9999.

Click OK to insert the date and close the dialog box.



    Inserting a calendar
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{button ,JI(`>HowTo',`IDH_DateMan_CNT')} How to display the Date Manager dialog box

Select the Calendar tab to insert a monthly calendar in your document. Calendars cannot be inserted inside a table, 
or in a macro document. If inserting a calendar is not possible, the Calendar tab is unavailable. 

After you have selected the month/year and the calendar formats (see below), click OK. The dialog box 
stays open, allowing you to insert additional calendars. 

If you only want to insert a single calendar, hold down SHIFT while you click OK. This closes the dialog box, 
and then immediately insert the calendar.

Selecting the month and year 
In the Calendar group, select the month and type the year for which you want to insert the calendar in your document.
To revert back to the calendar of the current month, click the “T” button.

USA or European Format. The calendar is automatically displayed in the format used in the selected country, with 
weeks either starting on Sunday or Monday. You can override this setting in the First Weekday group. The first option 
button refers to Sunday, the second one to Monday.

Language Options. The calendar is displayed and inserted in the language you select in the Language/Country list. 

Formatting the calendar
You can specify the format of the calendar to almost any detail. 

Title Font. Select which font you want to use to format the name of the month and the year at the top of the 
calendar.

Calendar Font. Select which font you want to use to format the names of the weekdays and the day 
numbers.

Calendar Size. Select the width you want the calendar to have. Specify a value and choose the unit. You 
can be very precise; decimals are allowed. Choose the Auto option to insert the calendar in the largest possible size. 
In most cases this will create a calendar over the full page width. If the document is formatted in columns, the 
calendar will be created to fit the column width. Note however, that the calendar will never be smaller than 84 pt 
(approx. 1.2 in or 3 cm).

Borders. Select your border options. To apply a simple default border, leave the appropriate box checked. If 
you want to apply special borders, colors and shading, check the Display Border Toolbar box. You can then apply any
special effects from this toolbar.

After you have inserted the calendar, all selected formats will be the default the next time you run Date 
Manager

{button ,JI(`>HowTo',`IDH_CALHINTS_DATEMAN')} Calendar hints 
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Tip 1. If you have created and formatted a calendar that you want to insert more often, you can save it as an AutoText
entry. The steps:
1 Choose Select Table from the Table menu
2 Choose AutoText from the Edit menu. The name of the month and year are automatically proposed as the 
AutoText name. 

3 Click Add to confirm the action. 
From now on you can paste the calendar quickly and easily from the AutoText dialog box into any document.

Tip 2. To create a large calendar that you can hang on the wall, do the following:
1 Create a new document and set it up in landscape mode. 
2 Choose the smallest left and right margins your printer can handle (e.g. 0.4 in). 
3 Run MegaWord Date Manager and select the Auto option.



    Biorhythm calculations
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{button ,JI(`>HowTo',`IDH_DateMan_CNT')} How to display the Date Manager dialog box

MegaWord BioRhythm is an implementation of the BioRhythm theory which states that three internal cycles influence 
us from birth to death: a 23-day physical cycle, a 28-day emotional cycle, and a 33-day intellectual cycle. Each cycle 
goes through a positive phase and a negative phase. During the transition from one phase to another there’s a very 
short critical phase. MegaWord BioRhythm calculates the cycles for any combination of birth date and reference date 
and tells you what your current physical, emotional and intellectual state is. You can look back to see why things went
wrong in the past, or look ahead to plan future actions. If you believe in the biorhythm theory you can use it to guide 
you through your activities. If you’re skeptical, you can use this macro to prove that the theory is absolute non-sense. 
And if you’re just curious, it'll give lots of fun!

Running BioRhythm
Biorhythm works automatically once you have set your birthdate. Click the Birth Date button to specify the day, month
and year you were born, then click OK to confirm. After that your birth date will always be used as the default. To find 
the biorhythm status for any date in the past or future, select the appropriate date in the “Selected date” group. The 
box at the bottom of the dialog box gives you information about the status of each biorhythm cycle. If any cycle is 
critical, it's considered a risky day.

Hint    To calculate your biorhythm and see your “advice of the day” without displaying the Date Manager dialog box, 
hold down SHIFT+CTRL and click .



    Number Manager

 Options...

MegaWord Number Manager lets you insert any number, in any format, in any language. It’s also a sophisticated 
calculator; speaking more than 20 languages, with powerful shortcuts for instant calculations on the selected text

Running Number Manager
Click 

 to display the Number Manager dialog box. 

If you made a selection in your document, Number Manager analyzes the selection. 
If the selection is a number, it is displayed as the start value in the calculator display. If the selection is a 

calculation, e.g. “125*5%”, Number Manager performs the calculation and displays the result (in this case 6.25) as 
the start value. 

If you have selected a range of cells in a table, Number Manager calculates the total of all numeric values in 
these cells and uses that total as the start value. 

If the selection isn’t recognized as a numeric value, the calculator displays zero.

{button ,JI(`>HowTo',`IDH_SHORTCUT_NUMBERMAN')} Inserting numbers without displaying the Number Manager 
dialog box

{button ,KL(`Number Manager')} How do I work with Number Manager?



    Shortcuts

 Start of    topic      
 More options...

If the selected document text holds a number or calculation (e.g. 1234*18%), you can insert the result of the 
calculation without displaying the Number Manager dialog box. These are the options:

Hold down SHIFT and click 
 to insert the result as a number (e.g. 222.12)

Hold down CTRL and click 
 to insert the result in currency format (e.g. $ 222.12))

Hold down SHIFT+CTRL and click 
 to insert the result as text (e.g. two hundred twenty-two)



    Inserting a number

 Start of    topic      
 More options...

{button ,JI(`>HowTo',`IDH_NumberMan_CNT')} Displaying the Number Manager dialog box

In the "Insert As" group, select "Field" to insert the number as a field which you can later modify or update, 
select "Plain Text" to insert the number as regular text. 

If you have selected "Calculator Box" from the "Number to Insert" list and "Full Number" from the "Number 
Format" list, you can also choose "Copy to Clipboard" to copy the number to the Clipboard, from where you can paste
it anywhere in your document. In all other cases this option is unavailable. 

Click Insert to insert the formatted number in your document. 

How a number is inserted
If you have selected text in the document before running Number Manager, the result can be inserted in two ways, 
depending on the status of the "Replace Selection" box.

With the box checked, Number Manager deletes the selection, and inserts the result at the insertion point. 
E.g. if the selection holds the text "98+243", the new text will be "341".

With the box unchecked, Number Manager adds an equal sign after the selection, and inserts the result to 
the right of it. E.g. if the selection holds the text "98+243", the new text will be "98+243 = 341". 



    Using the calculator to create a number
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{button ,JI(`>HowTo',`IDH_NumberMan_CNT')} Displaying the Number Manager dialog box

The Calculator performs all calculations of regular handheld calculators. The functions are spread over four button 
groups:

Input group. Holds the numbers 0 - 9 and the decimal character. Click any button to compose a number. 
Note: you must use the mouse to input numbers.

Execution group. Holds the standard calculation keys (÷, x, +, %) plus keys to calculate square roots (V¯), 
powers (^) and reciprocal values (1/x). Use the ± key to change the sign of the number.

Memory group. Lets you store and use memory values. MC clears the memory value, MR recalls the stored 
memory value and places it in the readout box, MS stores the current readout value in memory, M+ adds the readout 
value to the value already in memory.

Correction group. Lets you modify the value in the readout box. C resets all calculations and places a zero 
value in the readout, CE only clears the last entry and lets you input a new entry, <– lets you delete figures from the 
readout one by one.



    Calculator operating modes
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{button ,JI(`>HowTo',`IDH_NumberMan_CNT')} Displaying the Number Manager dialog box

The Number Manager calculator can operate in two modes: Calculator Mode and Input Mode. 

The initial mode is Calculator Mode. You can use the calculator like any other calculator, except that you 
must use your mouse to operate it. 

In Input Mode, all calculator buttons are disabled, but you can freely type any number or calculation in the 
calculator display. You can include the following operators: + (Addition), - (Subtraction), * (Multiplication), / (Division), 
% (Percentage), and ^ (Powers). Use brackets to change precedence. The following are examples of valid entries:

123*56/(34-12) returns: 313.0909090909
4566.56*6.7%*(12+8/9) returns: 3943.4782577778

After you have typed in a calculation, switch back to Calculator Mode to see the result.

You can at any time toggle between Calculator Mode and Input Mode. For example, you can make a calculation in 
Calculator Mode, then switch to Input Mode to make changes in the calculator display, and go back to Calculator 
Mode to make further calculations on the number you have just modified.

Displaying and hiding thousand separators
By default, Number Manager doesn't display thousand separators. 

Check the "Show Thousand Separators" box to group the numbers in the readout; uncheck the box to 
remove thousand separators from the display.



    Number types you can insert
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In addition to a number you type in the calculator display, or the result of a calculation, Number Manager can also 
insert the following types of numbers in your document. They are available from the "Number Type to Insert" list.

Page number
No. of Pages
No. of    Characters
No. of    Words
Day
Month
Year
Hour (1-12)
Hour (0-23)
Minute

These options are especially interesting when you want to format them in an unconventional way.
{button ,JI(`>BackInfo',`IDH_EXAMPLES_NUMBERMAN')} Examples



    Formatting the number, choosing a language 
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{button ,JI(`>HowTo',`IDH_NumberMan_CNT')} Displaying the Number Manager dialog box

The "Available Formats box" offers many ways to format the number you want to insert. See the list below.

Choosing a Language
The Language list. automatically comes up with the language of the current document. Initially the Language list is 
grayed out, but if you choose a format that expresses the number in literal text (shown in Italic in the following list), 
the number can be inserted in any of the 21 languages supported by Word. 

Available number formats
(Examples are shown in brackets, formats shown in italics can be formatted in the selected language.)

Full number    (12.345678)
Integer (12)
Two decimals (1234.56)
Percent (1234.56%)
Thousand sep., 2 decimals (1,234.56)
Thousand sep., no decimals (1,234)
Currency ($123.45)
Ordinal number (12th)
Ordinal text Lowercase (twelfth)
Ordinal text Uppercase (TWELFTH)
Text Lowercase (twelve)
Text Uppercase (TWELVE)
Text with fraction (Twelve and 33/100)
Roman Uppercase (XII)
Roman Lowercase (xii)
Alphabetic Lowercase (q)
Alphabetic Uppercase (Q)
Hexadecimal (C1)



    Number Manager examples
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Literal page numbers
To insert page numbers in the following format in your document: twelfth page of sixteen, do the following:
1 Choose "Ordinal text Lowercase" in the "Available Formats" box
2 Choose "Page number" in the "Number Type" box
3 Choose "Field" in the "Insert As" box
4 Click "Insert"
5 Type " page of "
6 Choose "Text Lowercase" in the "Available Formats" box
7 Choose "No. of Pages" in the "Number Type" box
8 Choose "Field" in the "Insert As" box
9 Click "Insert"

A Fancy Date Format
To create the following date format: Thursday, July 15th, 1993, and to store it for use at any moment in the future do 
the following (you only have to do this once):

1 Run MegaWord Date Manager 
2 Choose the option that shows the current weekday in the "Available Formats" box. Don't change the defaults in 
the other boxes

3 Click "Insert"
4 Type ", " (a comma and a space)
5 Run MegaWord Date Manager again
6 Choose the option that shows the current month name in the "Available Formats" box. Don't change the defaults 
in the other boxes

7 Click "Insert"
8 Type a space
9 Run MegaWord Number Manager 
10 Choose "Ordinal number" in the "Available Formats" box
11 Choose "Day" in the "Number Type" box
12 Choose the first option in the "Insert As" box
13 Choose the Insert button
14 Type ", " (a comma and a space)
15 Run MegaWord Date Manager 
16 Choose the option that shows the current year in the "Available Formats" box. Don't change the defaults in the 
other boxes

17 Click "Insert"
18 Select the four fields and the text between the fields
19 Choose Edit AutoText, type "MyDateFormat" in the "Name" box
20 Click the Add button

From now on you never have to go through this sequence again. Just choose Edit AutoText, select "MyDateFormat",
and click "Insert". This inserts your fancy date format in your text. Place the selection point somewhere in the date 
and hit F9 to update the contents. Done!



    Number format limitations
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Although Number Manager lets you combine any format with any number type, some combinations don't make 
sense, like a dollar format for your wordcount, or a hexadecimal representation of the current month value. The 
macro doesn't warn you if you choose one of these odd combinations and obediently formats the value the way you 
want it. 

It's also good to know that some formats can only be applied to numbers within a limited range. For example, Roman 
numbers can't be used for negative values and have a ceiling of 3999 (MMMCMXCIX). Cardinal text has an upper 
limit of 999999 (Nine Hundred Ninety-Nine Thousand Nine Hundred Ninety-Nine). If you go beyond the limits, 
Number Manager will give you a warning.



    Word Lock
MegaWord Word Lock keeps prying eyes from your work. It instantly covers your current document with a blank 
document, then covers your entire computer screen with a password dialog box. When Word Lock is active, your 
entire screen is locked - you can’t use ALT+TAB to activate other applications.

Running Word Lock
To lock the Word screen, do one of the following:

Click 

Press CTRL+ALT+SPACEBAR

The first time you run Word Lock you are prompted to provide and confirm a password, of up to 15 characters. Be 
sure to remember your password, because without typing a correct password you won’t be able to unlock your Word 
screen. The password is stored in encrypted form in more than one location on your computer.

To unlock the Word screen, type the correct password and click OK.
After a third invalid password, WordLock saves all documents, and then closes Word.



    Word Optimizer™

 Options...

MegaWord Optimizer lets you tweak Word for optimum performance, and personalize Word's standard settings

Why Word Optimizer?
Word comes with a number of "factory settings", aimed at the average user. A large number of these settings can be 
changed to make Word faster and better suited to your needs. Word Optimizer provides a friendly interface to guide 
you through these settings. It gives background information and suggests authorized values for faster opening, 
saving, scrolling, finding and replacing. After you have made your choices, Word Optimizer stores your preferences in
the Windows Registry. You must exit and restart Word to see the effect of your settings.

Running Word Optimizer
Click 

 to start the Word Optimizer

{button ,KL(`Word Optimizer')}How do I work with Word Optimizer?



    Changing and resetting values
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In the "Category" list, select one of the six setting categories: Performance, Date and Time, Filename 
Extensions, Network and DDE, File Locations and Misc. Settings. When you select a category, the "Keys" list is 
updated to show all related setting names, as they are used by Word. 

To understand the meaning, or view or change any of these setting, click on the setting name. The "Current 
Setting" box displays what the current setting value is, and the "Key Info" box provides you with relevant background 
information and hints about recommended setting values.

To change the value of the selected setting, follow the guidelines in the "Key Info" group, then type or select 
your choice under "Change into:" and click Set. Important: you must click Set for each setting you change! The 
information is immediately stored in the Windows registry. 

You can at any time revert to Word's original "factory setting" by clicking Reset. 
When you're done, click Close. The settings you have specified will become active the next time you start 

Word.

While the Optimizer dialog box is displayed you can modify as many settings if you want. If, for one reason or 
another, you're not certain about what you have done, simply click Undo. This will cancel all changes you made and 
restore the settings that were active before you started Word Optimizer. 



    Setting file locations

 Start of    topic      
 More...
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For your convenience Word Optimizer also has a File Locations item in the list. This displays the same dialog box as 
the one you see when you choose Options from the Tools    menu, and then activate the "File Locations" tab. When 
this dialog box is displayed, click Help for more information. Settings you change in this dialog box become 
immediately active after you have confirmed them.



    Shut Down
MegaWord Shut Down gives you three ways to exit Word and three ways to exit Windows, all from a single dialog 
box

Running Shut Down
To display the Shut Down dialog box, do one of the following:

Click 

Press ALT+F4
Choose Exit from the File menu

Note: clicking  in the upper right corner of your Word screen will close Word without displaying the MegaWord 
Shut Down dialog box.

The “Exit Word” options in the Shut Down dialog box speak for themselves. The “Shut Down” options are the same 
as the ones you see when you choose Shut Down from the Windows Start menu.

Check the “Reopen all current documents” box to reopen all current documents in your next Word session. 

{button ,JI(`>HowTo',`IDH_SHORTCUT_SHUTDOWN')} Fast Exit options



    Shut Down Fast Exit options
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Shut Down offers three alternative exit options, without displaying the Shut Down dialog box. In all cases your 
documents are automatically saved before Word is shut down. 

Hold down SHIFT and click 
 to exit Word

Hold down CTRL and click 
 to log off and back on

Hold down SHIFT+CTRL and click 
 to shut down your computer



    Task Switcher

 Options...

MegaWord Task Switcher lets you activate any running task from a dialog box, and adds two nifty features that the 
Windows Taskbar doesn’t offer. 

Each task can be given an “on top” status, which makes it always visible, regardless of the application you’re
working on. 

You can instantly create a split screen, placing Word together with any other running application. 
Task Switcher also gives you instant access to the Windows Task Manager.

Running Task Switcher
Click 

Running the Windows Task Manager
Hold down SHIFT and click 

{button ,KL(`Task Switcher')} How do I work with Task Switcher?



    Task switching from within Word
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To activate a selected task from the Task Switcher dialog box, click Switch to Task.

Select one of the options that determine how the task appears on your screen:
Normal. The task is activated and displayed in its normal state.
On top. The task is activated and stays on top of other applications, even if it wasn’t designed that way. This

is a handy option if you want to display a clock application or the Windows Calculator.
Together with Word. The task is activated and shares the screen with Word. In a side-by-side or top-to-

bottom arrangement you can easily drag and drop information between the two applications.
When you select the    "Together with Word" option, you can also determine where Word is displayed 

compared to the second application: at the left, the right, the top, or the bottom of the screen.

To terminate a selected task from the Task Switcher dialog box, click End Task.



    Working with the Windows Task Manager
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Compared to the Taskbar, the Windows Task Manager makes it a lot easier to activate other applications, run a new 
application, or arrange application windows over your screen. You can use CTRL+CLICK to select multiple applications
and minimize or close them in a single command. 

To activate the Task Manager, do one of the following:
If the MegaWord Task Switcher dialog box is displayed, click Windows Task Manager
If not, hold down SHIFT and click 



 Tip of the Day      
 
 More Tips...

To get a complete overview of all MegaWord tools, choose “MegaWord Help” from the Mega menu. Then double-click
“Overview of MegaWord Tools”, and double-click “Quick View of all MegaWord 95 applications”. 
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 More Tips...

To get instant Help about any MegaWord tool, choose “About MegaWord” from the Mega menu and select the Help 
tab. 
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 More Tips...

To insert the current date without displaying a dialog box, hold down CTRL and click  
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 More Tips...

To quickly sort select text from A-Z, hold down CTRL and click .
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 More Tips...

To increase the current zoom factor, click  or press ALT+PLUS (on the numeric keypad)
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 More Tips...

To display information about the current document on the titlebar, hold down CTRL and/or SHIFT and click .
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 More Tips...

To copy the contents of a table cell across a range of adjacent cells in the same row or column , select the range of 
cells (make sure that the cell you want to copy is the first one in the selection), then hold down SHIFT and click  on 
the Table toolbar
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 More Tips...

To split the document in two equal halves, hold down ALT and press the slash key (/). To remove the split, place the 
insertion point in the pane you want to keep open, and press the same key combination.
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 More Tips...

To create a copy of the current document and place the two copies side by side, hold down CTRL and click 
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 More Tips...

To arrange all open document windows from top to bottom, hold down CTRL and click 
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 More Tips...

To insert an accented character in your document, type the character without an accent, then press ALT+F3 or click
.
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 More Tips...

You can quickly reload any document you have worked on in the past, no matter where it’s located. Activate 
Document Recall (Mega menu) for more details.
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 More Tips...

To quickly correct the spelling of a word, or replace a word with a synonym, right-click on the word and select 
FastProof from the menu.
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 More Tips...

To run Word’s Spell Checker, hold down SHIFT and click  
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 More Tips...

To add ultrafast navigation features to a document, click  
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 More Tips...

To reload all currently open documents in a future session, click  and save your session as a Project.
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 More Tips...

To get a quick word count for the text between the start of the document and the current insertion point:, hold down 
CTRL and click .
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 More Tips...

To create a split screen, and place Word next to any other running application, click .



 Tip of the Day      
 
 More Tips...

To quickly place a word or paragraph between a pair of matching quotes, brackets or dashes, click .
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 More Tips...

To quickly repeat a format you’ve previously selected from the Format or Table menu, hold down CTRL and select the
same menu option again.
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 More Tips...

To automatically send your fax messages to your fax device rather than to a printer, click  and set your AutoFax 
preferences.
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 More Tips...

MegaWord replaces and enhances many existing Word commands and dialog boxes. To temporarily revert to Word’s 
original functionality, hold down SHIFT when you run the command.
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 More Tips...

To quickly open a project that you have created with MegaWord Project Manager, hold down CTRL and click . Then
double-click any file in the list. 
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If you load a document that you have created with earlier    versions of Word, click .to give the document a new 
descriptive name of up to 255 characters.



 Tip of the Day      
 
 More Tips...

To repeat the last Font format, hold down SHIFT and click 
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 More Tips...

To repeat the last View you have selected from the View Manager dialog box, hold down CTRL and click 
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 More Tips...

To reset the zoom factor to 100%, hold down CTRL and click 
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 More Tips...

To insert a number in currency format, type the number or calculation (e.g. 1234*18%) in your document, select it, 
hold down CTRL and click .
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 More Tips...

Press CTRL+ALT+SPACEBAR to keep prying eyes away from your document, and instantly hide Word behind a 
giant password box.
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 More Tips...

Hold down SHIFT and click  to save all documents and exit Word.
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 More Tips...

Don’t forget to register your copy of MegaWord! The Registration form is in the MegaWord Quick Reference Guide.
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 More Tips...

If you need technical support, choose “About MegaWord” from the Mega menu and click Tech Support.
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 More Tips...

To move a button from one of the MegaWord toolbars to another toolbar, hold down ALT and drag the button to its 
new location..
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 More Tips...

It is NOT recommended to copy parts of the MegaWord template to NORMAL.DOT or another template. Many 
macros rely on each other, and cannot be separated from the original template. For the same reason you should not 
delete or rename macros in this template, nor rename !MEGA_95.DOT. Technical support is only available if the 
original template is intact! 
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 More Tips...

To read your “Biorhythm “advice of the day, hold down SHIFT+CTRL and click 
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 More Tips...

To decrease the current zoom factor, click  or press ALT+MINUS (on the numeric keypad)
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To arrange all open document windows in "cascade" style, hold down SHIFT and click 
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To repeat the last symbol you inserted, hold down CTRL and click 
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 More Tips...

You can quickly reuse any template you have previously used to create a new document, no matter how long ago. 
Activate Document Recall (Mega menu) for more details.
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To find the first misspelling in the current document and display the FastProof dialog box, hold down SHIFT+CTRL 
and click  



 Tip of the Day      
 
 More Tips...

To restart your next session with the same documents as your current session, click  and select your options from 
the Auto Session tab.
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 More Tips...

To have your document automatically spell-checked before you print it, click  and select your AutoSpell options.
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 More Tips...

To repeat the last Paragraph format, hold down CTRL and click 
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 More Tips...

To zoom in to Page Width scale, hold down CTRL and click 
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To run Word’s Synonym program, hold down CTRL and click  
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To activate another Windows task (e.g. the Calculator) and place it on top of other windows, click .
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To toggle between Black on White and White on Blue text, hold down CTRL and click 
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To zoom in to Full Page scale, hold down CTRL and click 
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 More Tips...

To arrange all open document windows from left to right, hold down SHIFT+CTRL and click 
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 More Tips...

To insert the result of a calculation (e.g. 1234*18%), type the formula, select it, hold down SHIFT and click .



 Tip of the Day      
 
 More Tips...

Hold down CTRL and click  to save all documents and quickly exit and restart Windows.
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 More Tips...

Many MegaWord dialog boxes have a Tip button. Click it to find out about additional startup features.
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 More Tips...

To create a backup of the current document in another folder or on another drive, click .
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 More Tips...

To insert a number as literal text, type the number or calculation (e.g. 1234*18%) in your document, select it, hold 
down SHIFT+CTRL and click .
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 More Tips...

Hold down SHIFT+CTRL and click  to save all documents and shut down your computer.
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 More Tips...

To temporarily disable MegaWord 95, choose File/Templates, then remove the checkmark in front of the !
MEGA_95.DOT template. 
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 More Tips...

To create a new document, based on the same template as the current document, hold down SHIFT+CTRL and click
.
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 More Tips...

To open a document from the same directory, and with the same extension as the current document, hold down 
SHIFT+CTRL and click .
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 More Tips...

If you have Word set up for fast saves (which makes files a lot larger than normal), hold down SHIFT+CTRL and click
.to temporarily disable fast saves and reduce the document size.





    Virus Alert™
MegaWord Virus Alert helps you fight the dangers of so-called "document viruses". These are imported via 
documents that contain a macro that runs invisibly when you open the document. This macro adds new macros to 
your Word environment that can wipe out data, and invisibly infect documents you create later. When you distribute 
an infected document, the virus contaminates each computer in which the document is loaded. Virus Alert is designed
to keep those viruses away from your system, by disabling the work of AutoOpen macros. 

Running Virus Alert
To activate Virus Alert, do one of the following:

Click 

Choose Virus Alert from the Mega menu

The dialog box offers the following options:
Don't check for possible Document viruses. This disables Virus Alert.
Warn me if a Virus could be present. Each time you open a document that holds an AutoOpen macro, you

are prompted to run that macro or not, or to close the document immediately. This is the recommended    setting.
Disable Automatic macros completely. This disables all so-called “Auto” macros. The drawback is that 

also AutoNew, AutoClose, AutoExec, and AutoExit macros are disabled, which can have adverse effects when you 
load templates, or create new documents.

Note. Virus Alert does not clean up your system if it has been infected. Since document viruses can enter your 
system under any name, you are advised to check your global template (NORMAL.DOT) for macros that don’t look 
familiar. Specifically, you should look for a macro with the name “FileSaveAs”. If you never created a macro with that 
name, it may have been created by the virus. If you did create a FileSaveAs macro, you should open it for editing and
make sure that it’s really yours.



    Power Buttons
MegaWord Power Buttons add new functionality to the three toolbar buttons you probably use most: the New, Open 
and Save buttons on the Standard toolbar. In all cases, holding down SHIFT+CTRL while you click the button changes 
the behavior of these commands.

To create a new document, based on the same template as the current document, hold down SHIFT+CTRL 
and click 
.

To open a document from the same directory, and with the same extension as the current document, hold 
down SHIFT+CTRL and click 
.

If you have Word set up for fast saves (which makes files a lot larger than normal), hold down SHIFT+CTRL 
and click 
.to temporarily disable fast saves and reduce the document size.




